User’s Guide

SMART Board™ Software
for Windows 98, 2000, ME, XP
and Windows NT®

SMART Board Interactive Whiteboard
Rear Projection SMART Board Interactive Whiteboard
SMART Board for Flat-Panel Displays Interactive Whiteboard
Sympodium™ Interactive Lectern

SMART Technologies Inc.
Registration Benefits

In the past, we’ve made new software features such as handwriting recognition, USB support and SMART Recorder available as free upgrades. Register your SMART product to be notified of free upgrades like these. If you have a front projection SMART Board interactive whiteboard, you’ll receive an additional three years of warranty coverage when you register.

Keep the following information available in case you need to contact Technical Support:

Serial Number

Date of Purchase

Register online at: www.smarttech.com/registration

Trademark Notice

SMART Board, Symposium, DVIT, X-Port, Notebook, OptiPro, LinQ and the SMART logo are either registered trademarks or trademarks of SMART Technologies Inc. Microsoft, Windows, Windows NT, PowerPoint and NetMeeting are either registered trademarks or trademarks of Microsoft Corporation in the U.S. and/or other countries. Macromedia and Flash are registered trademarks of Macromedia, Inc. in the U.S. and/or other countries. Adobe, Acrobat and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the U.S. and/or other countries. All other third-party product and company names are mentioned for identification purposes only and may be trademarks of their respective owners.

Copyright Notice

© 1995–2005 SMART Technologies Inc. All rights reserved. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language in any form by any means without the prior written consent of SMART. Information in this manual is subject to change without notice and does not represent a commitment on the part of SMART.

Portions of this software are copyrighted by Intel Corporation.
Portions of this software are copyrighted by ParaGraph, a business unit of Vadem.
CalliGrapher® Copyright © 1997–2005 ParaGraph, a business unit of Vadem.


Important Information for Owners of Front Projection Interactive Whiteboards

Before you use the SMART Board™ interactive whiteboard, please read and understand the safety warnings and precautions described in this section. These safety warnings and precautions instruct you in the safe and correct operation of the interactive whiteboard and its accessories so you can prevent injuries to yourself or other persons and damage to equipment. You must always ensure that the interactive whiteboard is being used correctly.

In this section, the term “interactive whiteboard” refers primarily to the interactive whiteboard and its power supply accessories. Please also ensure that you read the safety warnings and precautions that come with or otherwise accompany your peripheral products, such as your computer and your projector.

**NOTE:** If you own a SMART product other than a front projection SMART Board™ interactive whiteboard, refer to the installation manual that came with your product for relevant warnings and maintenance instructions.

Safety Warnings and Precautions

<table>
<thead>
<tr>
<th>WARNING</th>
<th>Do not stare into the beam of light created by the projector. Instruct children not to look in the direction of, or stare at, this beam of light.</th>
</tr>
</thead>
<tbody>
<tr>
<td>WARNING</td>
<td>Failure to follow the installation instructions shipped with the interactive whiteboard could result in personal injury and damage to the product.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Do not mount the SMART Board 660 or 680 interactive whiteboard on an FS570 floor stand. Using this older stand could result in product damage or personal injury.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Message</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Do not climb (or allow children to climb) on the wall-mounted SMART Board interactive whiteboard. Climbing on the interactive whiteboard could result in personal injury and product damage.</td>
<td></td>
</tr>
<tr>
<td>You must connect the USB cable that came with your interactive whiteboard to a computer that has a USB-compliant port and that bears the USB logo. In addition, the USB source computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to the SMART Board interactive whiteboard.</td>
<td></td>
</tr>
<tr>
<td>To reduce the risk of fire or electric shock, do not expose the interactive whiteboard to rain or moisture.</td>
<td>Two people are required to mount the interactive whiteboard on a wall because the interactive whiteboard may be too heavy for one person to maneuver onto the wall-mounting bracket.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>Message</td>
</tr>
<tr>
<td>If you move an interactive whiteboard that is mounted on a floor stand, do so with care. Quick stops, excessive force and uneven surfaces may cause the interactive whiteboard to overturn. If your floor stand has anti-tip feet, retract them when you move the interactive whiteboard.</td>
<td></td>
</tr>
</tbody>
</table>
To ensure operating safety and to avoid product damage, read the following instructions carefully.

- Read the guide that came with your projector carefully, familiarizing yourself with all the warnings and cautions.

- If you are transporting the interactive whiteboard over a distance, completely repackage it using the original packaging. If the original packaging is no longer available, pack all components with as much padding as reasonably possible to ensure that they are not exposed to excessive vibration or shock.

- Avoid setting up and using the interactive whiteboard in an area with excessive levels of dust, humidity and smoke.

- Avoid leaving cables on the floor. If you must run a cable over the floor, lay the cable in a flat, straight line, and secure it to the floor with tape or a cable management strip in a contrasting color. Handle cables carefully and avoid excessive bending. You can eliminate the need for a cable by purchasing a SMART Wireless Serial Connection.

- If your floor stand has retractable anti-tip feet, make sure they’re extended when the interactive whiteboard is in use to ensure the greatest possible stability.

- Don’t add any extra weight or excessive pressure to the wall-mounted interactive whiteboard or its pen tray. The brackets are designed to support only the weight of the interactive whiteboard during normal use.

- If you require replacement parts, make sure the service technician uses replacement parts specified by SMART Technologies Inc., or parts with the same characteristics as the original.
Safety Tips for Teachers

- Tell students not to look directly at the light beam from the projector. Instead, encourage them to keep their back to the projector when working at the interactive whiteboard. Before they turn to face the class, they should take a big step (or even two) sideways.

- Make sure you don’t look directly into the light beam from the projector. Keep your back to the class when you write over a projected image. Step to the side of the interactive whiteboard before you turn and face the class.

- Tell your students not to touch the projector, as it can become extremely hot during normal operation.

- Don’t use a chair to increase a student’s reach. If your students can’t reach the top of the interactive whiteboard, lower it. You may need to remount a wall-mounted unit in a lower position. If your interactive whiteboard is mounted on a floor stand, lower it with the help of another adult.

- Tell students not to run in the vicinity of the floor stand, as they may trip over the floor stand legs.

More Information on Front-Projection Models

For further information on the front-projection SMART Board interactive whiteboard, see Maintenance for Front Projection Models on page 69, Troubleshooting Front Projection Models on page 73, and Wall-Mounting Tips for Front-Projection Models on page 81.
Contents

Important Information for Owners of Front Projection Interactive Whiteboards .............................................. i
  Safety Warnings and Precautions ........................................ i
  More Information on Front-Projection Models ...................... iv
  Safety Tips for Teachers ................................................ iv

Introducing SMART Board Software ........................................ 1
  Which SMART Products Use SMART Board Software .......... 2
  What Components Make Up SMART Board Software .......... 3
  What “Press” Means on SMART Products ......................... 4
  What State Your SMART Product Is In ............................ 4
  Where to Find More Information ..................................... 6
  Which Version of This Software Should You Install? .......... 7

What’s New ........................................................................... 8

Quick Tour ........................................................................ 9
  Advanced Features ........................................................ 11
  The Next Steps ............................................................. 12
  More Training ............................................................... 12

Controlling the Computer .................................................. 13
  Clicking ........................................................................ 13
  Aligning or Orienting the Interactive Screen ..................... 14
  Tips for Pressing ........................................................ 15
  Tips for Using DViT Technology .................................... 16
  Controlling a Projector or a Flat-Panel Display ................. 16
  Using Video Devices ...................................................... 18
  Displaying Your Computer Screen ................................. 19
Writing, Typing and Drawing .............................................. 21
  Writing in Ink Aware Applications ................................... 21
  Drawing in Ink Aware Applications ................................. 22
  Writing over Applications That Aren’t Ink Aware .............. 22
  Writing and Drawing in Notebook Software ...................... 24
  Writing Over Video .................................................. 27
  Typing Directly Into an Application or a Dialog Box ............ 28
  Typing and Formatting in Notebook Software ..................... 29
  Making Other Kinds of Notations .................................... 29

Adding Content into Notebook Software ............................... 30
  Using the Gallery ...................................................... 30
  Adding Web Links and File Attachments ............................ 33
  Adding Images and Flash Files ...................................... 34
  Other Ways of Adding Content to a Notebook Page ............... 35

Erasing ................................................................. 36
  Erasing Your Note ...................................................... 36
  Quick Erasing of Large Areas. ........................................ 37
  Restoring Lost Notes .................................................. 37

Capturing and Saving .................................................... 38
  Capturing with Floating Tools Screen Capture Buttons ........ 39
  Inserting Your Notes into Microsoft Word and Excel Files .... 40
  Inserting Your Notes into PowerPoint Software .................. 41
  Inserting Your Notes into Other Ink Aware Applications ....... 41
  Capturing Your Work as a Video ..................................... 41
  Saving the Notes You Make Over Videos ............................ 42
  Saving in Other Formats. ............................................. 42
  Saving Content from a Data or Videoconference .................. 42

Changing How the Software Works for You ........................... 43
  Changing the Way You Access Tools ................................. 43
  Adjusting the Notebook Interface .................................... 46
  Changing the Appearance of Digital Ink ............................ 48
  Recording a Different Screen Area ................................... 49
  Changing the Way You Use PowerPoint Software ................. 49
Sharing ................................................................. 50
  Sending Your Notes by E-Mail ................................. 52
  Printing Your Notes ............................................. 52
  Sharing Content from Other Applications .......... 53

Presenting ............................................................. 55
  Preparing Your Presentation ................................. 56
  Delivering Your Presentation ............................... 56
  Controlling What Your Audience Sees .................. 57
  Capturing, Recording and Saving Your Presentation .. 60
  Presenting Your Notebook File ......................... 60
  Using PowerPoint Software ............................... 62
  Other Ways to Present .................................. 63

Special Situations .................................................. 65
  Connecting Multiple SMART Interactive Products .... 65
  Using SMART Board Software in Non-Projected Mode ... 67
  Using the Display Control Icon Strip ................. 68

Maintenance for Front Projection Models .................. 69
  Cleaning Your Interactive Whiteboard and Pen Tray ... 69
  Removing Permanent Marker Ink Stains .................. 69
  Preventing Damage to the Writing Surface ............... 70
  General Tips for Trouble-Free Performance .............. 70
  Transporting the Interactive Whiteboard ............... 70
  Removing the Pen Tray .................................... 71
  Adjusting the Projected Image ............................ 72

Troubleshooting Front Projection Models .................... 73
  Understanding the Ready Light ......................... 73
  Troubleshooting Table ...................................... 74
  Resetting the Interactive Whiteboard’s Power ........ 79
  General Troubleshooting ..................................... 80

Wall-Mounting Tips for Front-Projection Models ............ 81
  Wall-Mounting Precautions and Tips ..................... 81
  Recommended Heights for Wall-Mounting ............... 83
  Securing the Pen Tray and Interactive Whiteboard .... 85
Introducing SMART Board Software

From the classroom to the boardroom, SMART products help you deliver dynamic presentations to students, prospective clients or co-workers. With SMART Board software, you can show documents, Web pages and videos on an interactive screen that responds to the touch of your finger or a pen.

For example, if you’re a teacher, you can prepare engaging lessons with Notebook software that are full of pictures, Macromedia® Flash® files and more. If you’re a corporate trainer, you can record one session using SMART Recorder, and then make the file accessible on the company intranet so others can review it later. You can also jot down notes during a meeting, take screen captures of the notes and then e-mail them to all participants.

These are just a few examples of how you can use SMART Board software. You’ll save time, resources and paper. And interactive products are fun to use!

Take a few minutes to read this guide and you’ll discover the many features that are available with SMART Board software. This guide is organized around the tasks commonly performed for preparing and delivering presentations. You may be inspired to use the interactive screen and SMART Board software to perform tasks that you traditionally did on paper or a chalk board.

If you’re a teacher, a professor or a corporate trainer, look for classroom-specific hints beside this picture when you see it throughout the guide.

When you see the picture on the left in this guide, you’ll find suggestions for meetings and demonstrations for the corporate world.
Which SMART Products Use SMART Board Software

SMART Board software works with front projection SMART Board, Rear Projection SMART Board, and SMART Board for Flat-Panel Displays interactive whiteboards, as well as Sympodium™ interactive pen displays and interactive lecterns. Because you could be using any of these products, the guide refers to “your SMART product,” instead of a specific one.

Tips in boxes beside this illustration are specific to all interactive products that have touch control.

An interactive pen display icon identifies tips specific to Sympodium products that have an ID250 interactive pen display.

Although you can install SMART Board software on any computer, you’ll notice some limitations if the SMART product isn’t connected to the same computer. Some features or applications may not be available unless you have an interactive product connected.

TIP

Record the serial number of your SMART product(s) in the front of this guide, in case you ever need to call SMART Technical Support for help.
What Components Make Up SMART Board Software

SMART Board software includes many tools and applications that will help you get the most out of your interactive product. This software includes:

- the SMART Start Center, to access tools, applications and files
- handwriting recognition, to convert your notes to typed text
- Notebook™ software, an application for creating and delivering presentations
- SMART Gallery tool, to insert images and templates on Notebook pages
- SMART Recorder, to save a recording of your on-screen actions
- SMART Video Player, to create notes over videos
- SMART Keyboard, an on-screen keyboard for inputting typed text
- Floating Tools, tools for writing notes and drawing shapes
- the SMART Board Control Panel, to change the software and hardware settings
- SMART Display Controls, to control your projector or flat-panel display at the interactive screen. With these controls, you can switch between a resident computer and a laptop.
- SMART Bulb Saver, a screen saver that preserves the life of your projector or flat-panel display
- Mobile and Wireless Device Settings, to display the desktops of a networked laptop computer that’s running SMART LinQ software on the interactive screen
- SMART Notebook Print Capture, to capture files to Notebook software
- SMART Board Diagnostics, a troubleshooting application

IMPORTANT
If you’re using the Windows® XP operating system with Service Pack 2 installed, you must change a setting in Internet Explorer to access the Help Center topics. Press Tools > Internet Options, and press the Advanced button. Under Security, select the Allow active content to run in files from my computer check box. To access the Help Center, press any of the Help buttons in SMART Board software.
What “Press” Means on SMART Products

By touching the interactive screen, you can use interactive features, control computer applications, and write notes over these applications in digital ink. However, depending on your SMART product, the method of touch varies.

While interactive whiteboards respond to any physical touch on the interactive surface, Sympodium ID250 interactive pen displays only respond to the special pen tool that comes with the product. In this guide, when you see “press” in the text—for example, press the button to close the window—the method of pressing depends on which product you have.

If you have a SMART Board interactive whiteboard, you can touch the button with your finger. However, if you have a Sympodium product, press the Left Click button on the pen display and then touch the pen tool tip to the interactive screen.

What State Your SMART Product Is In

This guide assumes that your SMART product is set up and ready to use, which means:

• your interactive product is properly installed. If your product uses a projector, that projector should be turned on and properly connected to the computer. If you have a Sympodium lectern, make sure you’ve turned on the interactive pen display and that the video cables are properly connected. When you look at the screen, you should see the computer desktop.

If you’ve turned on the necessary equipment and you still can’t see the computer’s desktop on the screen, read your product’s installation instructions to make sure the product was set up correctly. Also check that the interactive product is connected to your computer and a power source (if necessary).

Every SMART product has one or more light-emitting diodes (LEDs) that indicate the state of the product. Interactive whiteboards have a Ready Light and lights for each tool, while Sympodium products have Power and Status LEDs.

For 600 series interactive whiteboards, see page 73. If the Ready Light on a 500 series interactive whiteboard is solid green, your system is functioning properly. If it’s red, the pen tray is receiving power but it isn’t communicating with SMART Board software. If you
haven’t installed this software, do so before proceeding. If you have installed the software, ensure that the cable between the computer and the interactive whiteboard is secure at both ends. If you’re still having problems, call SMART Technical Support (see page 86) or your dealer.

• SMART Board software has been installed and is running in projected mode. If it is, you’ll see the SMART Board icon in the system tray. If you don’t see the icon, open the SMART Board Software folder from the list of programs in the Windows Start menu and select SMART Board Tools. If this folder isn’t there, you must install SMART Board software. You can do this from the CD, from a USB storage device or by downloading it.

The projected mode is the default mode for SMART Board software. You’ll find the mode setting in SMART Board Settings dialog box, which you can access from the SMART Board Control Panel. If you need more help determining the mode or changing it, open the SMART Board Software Help Center and search for information on Projected Mode.

• the interactive screen is properly oriented. Check the accuracy of your touch. When you press the interactive screen, you should see the pointer at the exact point of contact. If you don’t, orient the screen so the computer can accurately track your contact. See How To > Orient/Align the Screen in the SMART Board Software Help Center for step-by-step instructions, including changing the orientation level.

To begin the orientation process, simultaneously press the Right Click and the Keyboard buttons on the pen tray.

This guide is for users running Windows NT® 4.0 or the Windows 98, 2000 or XP operating systems. If you’re using the Windows 95 operating system, you must use SMART Board software version 7.1.3, which you’ll find on the installation CD or on www.smarttech.com. There, you’ll also find a matching version of the SMART Board Software User’s Guide. Check the SMART Board Software Help Center for more system requirements.
Where to Find More Information

This guide provides an overview of the many features of SMART Board software for a varied audience—from educators to business professionals and from beginner computer users to experienced users. For detailed information on the specific features of the software, explore the SMART Board Help Center. There, you’ll find procedures and instructions for each feature.

If you’re using a 600 series SMART Board interactive whiteboard, you can quickly access the Help Center by pressing the pen tray’s Help button. This button also gives you access to the orientation screen and the contact information for SMART Technologies.

The Help Center contains links to a wide range of information, including procedures for using each component (How To’s), descriptions of each tool and the concepts around using the components, troubleshooting hints, and more. As a result, you’ll find the level of information that you need to help you use SMART Board software.

You should also check www.smarttech.com for more resources. At this site, you’ll find information on each product, including setup instructions and specifications. This website’s Training Center has learning resources, free hands-on lessons and information on how to get more training. You’ll find up-to-date, product-specific information in the Support area of this website, including frequently asked questions (FAQs), technical bulletins and resource centers.

You’ll find lesson plans, good practices and other activities specific to teaching with a SMART product on www.EDCompass.com.

TIP

If you need to log on to your computer, you can do so right at the interactive screen. Press the Keyboard button on your SMART product to open the SMART Keyboard and then press the virtual keys to enter your user name and password.


**Which Version of This Software Should You Install?**

You can install the full version of SMART Board software on any computer. The full version comes with language packages that let you open the software with translated interface components, messages and Help files.

You can also install a condensed version of SMART Board software onto a USB storage device. This scaled-down version is ideal for preparing presentations on laptops. When you’re ready to present, you can open your file on the computer that’s connected to the interactive product, which will be running the full version of SMART Board software. You can install the USB storage device version of SMART Board software (**USB Board**) from the SMART Board software CD.

When you install SMART Board software, be sure you have the correct privileges for your operating system. Some operating systems let only a user with administrative rights install applications. Read the instructions that came with your operating system for details specific to your setup.

If you’re a network administrator, you can simultaneously install SMART Board software on any number of computers from one central location. To do this, use the command line arguments described in the Help Center topic *Customizing the Installation of the Software*.

If you need to uninstall SMART Board software, refer to the Help Center topic entitled *Uninstalling the Software* for details.

Depending on your operating system and network settings, you might have to log on to the computer before you can access SMART Board software.

If the SMART product is in a shared room, consider creating a meeting room logon identity for the computer that’s connected to the SMART product. Then give this identity access to commonly used applications, such as SMART Board software and Notebook software. This ensures that anyone who uses the meeting room can access the interactive tools and applications of SMART Board software.
What’s New

If you’ve used SMART Board software before, you’ll notice some changes in this version. These changes include:

• the Start Center. This customizable toolbar lets you access interactive tools or other programs.
• new Floating Tools, such as the Creative Pen, shapes and the Magnifier
• new views of the SMART Keyboard
• more content in Notebook software, including Macromedia® Flash® files
• easier access to common actions for objects on a Notebook page
• right-click behavior when you press and hold the interactive screen for approximately three seconds
• the appearance of a border when you write over non-Ink Aware applications
• a Web-like list of SMART Board Control Panel options, including the Mobile and Wireless Device Settings that let you use LinQ software on a laptop computer
• a setting in SMART Recorder for recording only a specific window or a rectangular screen area

For more details on these and many other features, read What’s New in the Help Center.
Quick Tour

When you press the interactive screen, the computer interprets your touch as a left-click, just as if you were using your mouse.

If you’re using a SMART Board interactive whiteboard, pick up a colored pen from the pen tray and write on the screen. If you’re using a Sympodium interactive pen display, press a **Colored Ink** button and write on the screen with the pen tool. When you start writing, the Floating Tools appear on your screen. You can use **Area Capture** button to save your notes.

If your product has a pen tray, use the eraser to erase the digital ink. If you’re using a pen display, press the **Eraser** button and drag the pen tool across the screen.

You can write a note on the screen over any application and convert your note to typed text by pressing and holding the note until you see a menu. Select one of the choices and the typed version of your note appears at the cursor location of your active file or dialog box.

If you’d rather type into an active application or dialog box instead of converting your handwritten note, use the SMART Keyboard. This on-screen keyboard has different views, so you can select the one that best suits you. To change the view, open the SMART Keyboard from the Start Center and then select the view you want. For example, you can open the Classic view of the SMART Keyboard to log on right at the interactive screen, or type numbers with the Number Pad view.
To access the many tools in SMART Board software, double-press the **SMART Board** icon in the system tray to open the Start Center. The Start Center is a vertical toolbar for quick access to the SMART Board tools and any other applications you add. You can customize the toolbar further by making it smaller or transparent.

Open Notebook software (press the top button in the Start Center) to create a presentation full of colorful clip art, Flash objects, graphics and text from a variety of sources. Drag any of the thousands of images, Flash files and templates available from the Gallery tab onto the pages of your presentation, or capture information from the Internet or any source on your computer. Rearrange your pages using the Page Sorter tab, and add file attachments and website addresses on the Attachments tab.

After you’ve created your content, you can present it with Notebook software. As your audience provides comments and suggestions, write their input on a Notebook page using the pen tray tools or the pen buttons in Notebook software.
For more help on performing specific tasks, open the Help Center by pressing the Help button on the Start Center. Or visit the Support and Training areas of www.smarttech.com for more ways to learn about SMART Board software.

If you’re a first-time SMART product user, you can practice using the interactive screen with two applications that were specially created for use with a SMART product: SMART Number Cruncher and SMART Speller. Download these simple programs from www.EDCompass.com to practice writing on the screen and to practice converting your writing to typed text.

Advanced Features

SMART Board software is about more than just writing and saving notes over still images on the interactive screen. For example, you can play a video with SMART Video Player and write over the moving images.

Record a file of everything you do at the interactive product with SMART Recorder. If you have a microphone connected, your file can include narration.

You can modify many of the tools in SMART Board software. For example, you can customize the Start Center by adding additional buttons, such as buttons for frequently used applications. When you open the Floating Tools, the Classic tool set opens by default, giving you access to the most commonly used tools. However, if you’re teaching younger students, you might want to try the Creative tool set. Read the Select a Tool Set in the How To > Change the SMART Board Software Settings folder of the Help Center for more information.
If you’re a guest laptop user who prefers not to install SMART Board software on your computer, you can simply connect your laptop to the interactive product and enjoy automatic touch control of your presentation.

**NOTE:** If you’re using the interactive product without installing SMART Board software, the LED on the product will blink continuously. This is normal.

You can also enable Mobile and Wireless Device settings at the resident computer and use LinQ software to display files on the interactive screen using a network connection. With this software, your files stay on your laptop while you use the interactive tools of SMART Board software on the SMART product to deliver a presentation.

**The Next Steps**

Challenge yourself to try new ways to do tasks that you normally do with paper and pen. The more you use SMART Board software, the more efficient you’ll become.

For example, SMART Board software helps you reuse information by encouraging you to save your material and notes on a computer instead of on paper. You can also share your files with others.

Ask yourself: How can I use this tool to make my daily tasks easier? Or What could I use this feature for? Your answers may surprise you.

**Become a SMART Exemplary Educator**

Become a SMART Exemplary Educator by using your SMART product in a valuable way and then sharing your knowledge with others. Check www.EDCompass.com for information on professional development opportunities.

**More Training**

If you need more training, go to www.smarttech.com/Trainingcenter and www.EDCompass.com. You can also use the exercises on these sites to teach others.
Controlling the Computer

Think of the interactive screen as an extension of your computer itself. Press the screen to click as you would with a mouse. Anything that you can do at your computer, you can accomplish at the interactive screen. For example, you can open the virtual SMART Keyboard so you can log on to your computer without using a physical keyboard.

If you can see the SMART Board icon in the system tray, you have access to all the interactive applications and tools included with SMART Board software. Press this icon to see a menu of items or double-click it to open the Start Center.

Press a menu item or a button on the Start Center to open that tool or application. You can also add buttons for other applications that you commonly use, like Microsoft® Internet Explorer, Word or PowerPoint® software, to the Start Center. You can have up to 11 buttons on the Start Center.

Clicking

Press on the interactive screen to left click (as you normally would with a mouse). Before you know it, you’ll be browsing the Internet, moving files and doing everything that you used to do with your mouse.

Press the interactive whiteboard firmly with your finger.

When you get the hang of this, you can take full advantage of SMART Board software.

If your press unintentionally produces digital ink or erases a previous note, check that the pens and the eraser are in their pen tray slots. If one tool isn’t in its slot, the sensors in the pen tray register your touch as if you were using that tool.

To double-click, press twice. For example, to open a program, press twice on its desktop icon.
Press the **Left-Click** button on a Sympodium interactive pen display and then touch the pen tool tip to the screen.

Tap twice for a double-click.

To right-click once, press and hold your finger or the pen tool on the interactive screen. You’ll see an information thumbnail and, in approximately three seconds, the right-click menu for the desktop or the active application appears. Another way to right-click is to press the **Right-Click** button on your interactive product and then touch the interactive screen to instantly see the right-click menu. After you right-click, your next press on the interactive screen reverts to a left click.

If your SMART product uses DViT™ (Digital Vision Touch) technology, you can use hand gestures to right-click. Read about them on page 16.

To move objects on the interactive screen, press the object with one finger and, while maintaining pressure on the object, use your other hand to touch the screen at the new location. Then lift the finger that’s holding the object. The object jumps to the new location.

**Aligning or Orienting the Interactive Screen**

To make your press to appear exactly where you expect it, make sure your SMART interactive product is properly aligned or oriented. This lets SMART Board software know exactly where the image is on the product.

Your SMART product comes with a default setting that aligns a standard computer screen image to the product. However, if the pointer appears a slight distance away from where you’ve pressed, you should correct this misalignment by orienting your unit.

To orient the unit, you press specific points on the interactive screen. You access this orientation screen by pressing the **SMART Board** icon or the **More** button on the Start Center and then selecting **Orient**. This procedure can be four, nine or twenty presses, depending on your **Alignment/Orientation Precision** setting,
which you can access in the *SMART Board Settings* dialog box from the SMART Board Control Panel.

For quick access to the Orientation screen, press the two pen tray buttons at the same time to orient the interactive whiteboard.

If you have a SMART Board 600 series interactive whiteboard, you can quickly open the Orientation screen from the Help button on the pen tray.

If you have a SMART Board 600 series interactive whiteboard, the orientation settings are stored with the product, not on the connected (resident) computer.

**Tips for Pressing**

Your SMART product interprets your screen presses using a number of default settings. One special setting is the *Mouse Assist* option. With this feature active, it’s easier to activate items like scroll bars and Close buttons, which may otherwise require precise pressing. With this setting, you can tailor your interactive product to the abilities of its users.

Don’t lean your palm, arm or anything else against the interactive screen. More than one point of contact with the interactive screen can confuse the product’s electronics.
If your students can’t reach the upper portion of the screen, you may be able to lower the screen. If you have an adjustable product such as a Rear Projection SMART Board 2000i interactive whiteboard or an interactive whiteboard on a floor stand, you can lower it. Remember to orient the front projection interactive whiteboard after you move it.

Avoid standing on a chair or a stool to reach the top of the interactive screen. Follow the safety tips outlined on page iv.

Some applications, like Notebook software, have a moveable toolbar. Drag it to the bottom of the screen so people can reach the buttons.

**Tips for Using DViT Technology**

If you have an interactive whiteboard that uses DViT technology, more than one person can interact with the product at the same time. However, you must first enable this **Multiple Touch Mode** before SMART Board software can recognize more than one press. You can change any of these settings through the **Mouse Settings** in the **SMART Board Settings** dialog box, which you access from the **SMART Board Control Panel**. Read the **Tips** section of the Help Center for more hints.

You can also use mouse gestures if your interactive screen uses DViT technology. Gestures are a way of mimicking a right-click or wheel-click by touching the screen.

With the gestures feature enabled, you can right-click by pressing the screen with one finger and then pressing with a second finger to the right of the first. In addition, you can wheel-click (or scroll) by touching the interactive whiteboard with two fingers and then moving your fingers up or down the screen. To use gestures, you must activate the **Enable Mouse Gestures** and the **Multiple Touch Mode** settings. See **How To > Change the SMART Board Software Settings > Change Mouse Settings** in the SMART Board Software Help Center for more information.

**Controlling a Projector or a Flat-Panel Display**

If your SMART product uses a projector or a flat-panel display, you can control these devices right at the interactive screen using the SMART Display Control. You can also set up a special screen saver that’s
optimized for a SMART Board interactive whiteboard, called the SMART Bulb Saver.

**Display Control**

SMART Board software comes with Display Controls that work with a screen saver to help preserve the life of your projector lamp or prevent an after-image on your flat-panel display. These controls can save money for you, because bulb and display replacements are expensive. When your screen saver is activated, the Display Control turns off the projector lamp or puts the flat-panel display into sleep mode.

With the Display Control set up, you won’t have to search for the projector’s or flat-panel display’s elusive remote control, because you can press an on-screen button to control the volume, power and input source.

To set up this feature, you’ll need an active screen saver and an appropriate data cable to connect the computer to the projector or flat-panel display. (This cable often comes with the projector or flat-panel display.) Then activate the **Display Control Settings** in the **SMART Board Settings** window (accessed from the **SMART Board Control Panel**). An icon appears in your system tray. Press this icon to access a menu of commands for controlling your projector or flat-panel display.

**SMART Bulb Saver**

Consider using the SMART Bulb Saver as your screen saver. It’s tailored for SMART products and, when you use it with the Display Control, it will help conserve the life of your projector lamp or flat-panel display. You can set the SMART Bulb Saver to activate after a period of computer inactivity or the absence of a video signal. You’ll find this screen saver with your operating system’s display settings. For complete information on setting it up, see **Activate SMART Bulb Saver** in the SMART Board Software Help Center.
Using Video Devices

Just like the sportscasters on television, you can play a video clip for your audience in SMART Video Player. As the video plays, you can circle players, draw lines and write comments over the images.

If you connect an external video device to your computer, such as a video camera or a VCR (using a video capture card or a TV tuner card), SMART Video Player automatically detects this hardware, and it appears on the Hardware menu. You can adjust your settings for this device and save your adjustments. When you next use this device for your video input, your settings are restored.

Open SMART Video Player to play the movie, using the buttons on the lower portion of the window to play, pause or stop the video.

When you want to draw attention to something in the movie, you can write a note over it with any interactive pen tool (a physical or a virtual one). Or you can use the Floating Tools to highlight or point out an important detail.

You can set up SMART Video Player to pause the movie as you make your note, or it can continue to play while your note slowly fades away.

If you press Pause in the SMART Video Player window while you’re showing a video from a video device, such as a VCR, the video displayed on the interactive screen pauses while the hardware device continues to play. When you return to the video, it will jump ahead.

TIP
Drag a video file from Windows Explorer to the opened SMART Video Player window to see the video immediately.

The Tools Available in the Video Player Window
Displaying Your Computer Screen

Sometimes when you present, your audience can’t see small details on the screen. To alleviate this situation, use the Magnifier to enlarge an area of your screen.

From the Start Center, press the More button and add the Magnifier tool. Drag the window around your screen to enlarge the area inside it.

Connecting a Laptop Computer to a 600 Series Interactive Whiteboard

If you want to use a laptop without installing SMART Board software, you can disconnect the data cable that came with your 600 series interactive whiteboard from the resident computer and connect it to the laptop. You’ll immediately have touch control of the oriented interactive whiteboard. However, you will need to connect a video cable between the laptop and the projector.

**NOTE:** With this setup, the Ready Light on the interactive whiteboard will continuously blink. This is normal.
Mobile Device Manager

If you’re using a laptop computer, you can display files from your computer on the interactive screen without connecting any cables. To do this, you must activate the Mobile and Wireless Device Settings (from the SMART Board Control Panel) to allow a laptop to connect using LinQ software. See page 51 for more information.

To use LinQ software, you must install it on your laptop and your laptop must be connected to the same network as the resident computer for the interactive product. You can download and read the LinQ Software User’s Guide. Search for it on www.smarttech.com/support.

Guest Laptop Switch

If you prefer to connect a guest laptop with cables and your interactive display supports laptop switching, you can set up the Display Control and use the guest laptop switch to alternate between the laptop and the interactive screen’s resident computer. This guest laptop switch also requires that your computer have two available serial ports and a video input port. To set this up, read the Help Center topic entitled Configuring the Guest Laptop Switch, or the overview entitled A Guest Laptop Switch.
Writing, Typing and Drawing

No matter which SMART interactive product you have, you can use its pen(s) to write or draw over or into any computer image.

Open any application by pressing twice on its desktop icon. Then use either the tools of SMART Board software or a pen tray pen (on interactive whiteboards) to write or draw, instead of a traditional mouse and keyboard.

Press a **Colored Ink** button on the Sympodium interactive pen display and use your pen to create digital ink in that color.

Write with your finger! Pick up a pen with one hand and touch the interactive whiteboard with your other hand. Digital ink appears in the trail of your finger.

Go ahead. Start writing!

Write often on the screen to keep your class interested, attentive and entertained. Let your students write on the screen too. Interacting with the lesson material helps your students learn through discovery, which leads to better retention of your lesson objectives.

Writing in Ink Aware Applications

With a number of applications, you can save your notes in the file that you have open. These integrated applications (e.g., Microsoft Word, Excel, Paint and PowerPoint) are called Ink Aware applications. For a complete list of these applications, the supported version and special functions within the application, see *SMART Board Control Panel > Using Ink Aware Applications* in the SMART Board Software Help Center.

When you use an Ink Aware application, write in the active area of the application. For Word, the active area is a page; for Paint, this area is the canvas area. If you move your pen outside of this area, the ink doesn’t appear. This makes it easy for you to press buttons on the toolbar with the
pen still in your hand. Also, SMART Board software knows the ink color to display based on the pen that you’re using.

**Drawing in Ink Aware Applications**

Microsoft Paint is one of several Ink Aware graphics applications. When you open Paint on the interactive screen, you can use a pen tray pen (or your finger) to draw a picture instead of using your mouse to select and then manipulate a tool from the Paint toolbox, as you would normally. Similarly, pick up the pen tray eraser and erase part of the picture. Or use the Paint toolbox to further enhance the object you're creating.

You’ll find you’ve created a bitmap with much greater ease than normal: You have the extra-large canvas of the screen to work on and the fine artistic control that can only be achieved with a pen in your hand. You'll also find these same advantages when you’re running CorelDRAW® or AutoCAD® software.

Refer to the SMART Board Software Help Center for a complete list of Ink Aware applications and versions.

For details on saving your notes with these Ink Aware applications, see the chapter on **Saving**, starting on page 38.

As you show a spreadsheet on the interactive product, you might need to amend some numbers based on discussions in a meeting. Open your Excel spreadsheet, press in the appropriate cell and write the new number on your interactive screen. Then press the **Insert as Text** button.

**Writing over Applications That Aren’t Ink Aware**

If you’re using an application that’s not Ink Aware, your writing appears on a transparency layer over a frozen image of the desktop. This layer and the Floating Tools appear when you pick up a pen tray pen.

You’ll know the transparency layer is there because a border appears around your screen. Inside this border, you can write or draw with digital ink, erase ink, or capture your notes to Notebook software. If you find the border distracting, you can remove it by pressing the **Right-Click** button on your interactive product, and touching the interactive screen. In the
menu that appears, press **Show Border** to remove the check mark and turn off the feature.

When you’re working on a transparent layer, don’t be alarmed if your computer clock in the system tray doesn’t change while the transparency layer is active. It will return to normal when you return to a left click.

**CAUTION**

SMART Board software clears your notes if you touch the screen after you put down a pen (interactive whiteboards) or press the Left-Click button (interactive pen displays). However, you can easily restore the notes, as described on page 37.

You can convert your handwritten note to typed text and insert it into your active, non-Ink Aware application. To do this, press and hold the note for approximately three seconds. You’ll see a menu that includes conversion choices. Select one for it to appear in your active application or dialog box.

For example, if you want to save a file with a different name, select **File > Save As** in the application, pick up a pen and then write the new name. Return the pen to its slot, and press and hold the new name until you see a menu. Select the correct conversion by pressing it and the name will appear in the **File Name** box of the Save As dialog box.

**Students will better understand how the technology works if you explain to them the concept of the transparent layer over the computer image.**

**Floating Tools**

The Floating Tools are more than just the virtual counterpart to the physical tools. In the Classic tool set (the default for SMART Board software), you have access to many other tools, including Area Capture and Highlighter. You can also add tools. For example, add the Shape and Creative Pen buttons to the Floating Tools so you can make your notes more engaging. For information on customizing the Floating Tools, turn to page 44.
To open the Floating Tools, press the Floating Tools button in the Start Center, or press the SMART Board icon in the system tray and select Floating Tools.

Press the Highlighter button to highlight text with yellow, semi-transparent digital ink, just as you would with a highlighter pen. You can cover words or any area of the screen with this illuminating ink.

**Writing and Drawing in Notebook Software**

If you’re using Notebook software on a SMART interactive product, the easiest way to write notes is with a pen tray pen (interactive whiteboards) or the Pen tool (Symposium interactive pen displays). However, you can also create freehand objects using the Pen and Creative Pen toolbar buttons and a range of geometric shapes using the Shape button.

You can write and draw in different colors, line widths and styles, ranging from artistic to plain. If you like, you can use the Creative Pen to write with a stream of stars, rainbow colors, happy faces or even flowers!

You can also write over Flash files that you add to your page. In fact, if the Flash file recognizes writing, it will convert your handwritten note to text.
With the pen in your hand, you can press the buttons in the Flash file to activate various components.

You can also use the Line button to connect your notes with lines that have arrowhead ends.

![A→B](image)

**TIP**

If you’re using Notebook software on an interactive product and you want to use the more creative tools that are available with SMART Board software, don’t use a pen tray pen! Instead, press the **Creative Pen**, **Line** or **Shape** buttons on the Notebook toolbar, and write with your finger in the workspace.

### Manipulating and Changing Notebook Software Objects

Whatever you write, draw or type on a Notebook page becomes an object that you can select and then resize, move, rotate, group with other objects, link and modify in many other ways.

![Object](image)

**Click to rotate**

**Menu Arrow**

**Click to modify, link, cut, copy, paste, lock in place, group, etc.**

**Click to resize**

### Grouping Objects

When you write several words in the same general vicinity on a page, you’ll notice that they’re already grouped when you select them. This is called smart grouping, and it occurs automatically when you create handwritten notes within the same area of the screen. This feature keeps words, sentences and paragraphs together on the screen, so you can easily move them as a group. This feature also allows you to easily select words and word groups as individual objects, rather than as clusters of the separate, multiple pen strokes that you used to create them.
You can deliberately group individual objects so you can manipulate them as one object. Select the objects, and then select Draw > Group.

Protecting Objects from Editing

You can protect an object or a group of objects from being moved, changed or grouped with other objects with the Draw > Lock in Place command. When selected, a locked object displays a Lock icon in its selection rectangle. Just click that icon to unlock the object.

Rearranging Stacked Objects

When you’re copying and pasting multiple objects onto the same page, they often become stacked on top of one another. You may want to rearrange them to reveal an object hidden within the stack.

Select the Bring Forward and Send Backward commands in the Draw > Order menu to rearrange selected overlapped objects, one position at a time, for selective visibility. The Bring to Front and Send to Back commands in the Draw > Order menu take selected objects to the upper and lower limits of the object stack; in other words, these commands move an object all the way to the front or rear of the stack.

Linking Objects to Websites or Files

You can also link an object to a website or a document on your computer or network. Just select Hyperlink from the selected object’s menu arrow (in the upper-right corner of the selection rectangle), and type the Internet address to which you want to link. Click OK and a hyperlink button appears with the object when you select it. Click the hyperlink button and your Web browser opens at the specified address.
Using Notebook Pages
With Notebook software, you can create a series of pages to accommodate even your lengthiest presentation. When you fill up one page with your notes, click the **Insert Page** button in the toolbar to add another one.

The Page Sorter tab provides a comprehensive overview of all Notebook pages in miniature form, and lets you perform all page-related tasks with ease. Open the Page Sorter to remove, clone and rearrange pages, as well as change the page titles. The Page Sorter is also convenient for moving and copying objects from one page to another.

While you’re working on a page in Page Width view, you can extend it to add room for more notes (click the words **Extend Page** at the bottom of the page) and you can change the background color.

Writing Over Video
With SMART Video Player, you can write or draw over moving or still video from a VCR or DVD player. To do this, you must first connect the VCR or DVD player to a video capture card on the computer. You can write over top of your video, play or freeze frames, and capture or clear your notes. When you capture a note, it’s automatically sent as a screen capture to Notebook software. See *How To > Save > Capture a Note with the Floating Tools* in the Help Center for details.

The ability to write over video will help you if you’re analyzing sports plays or investigating details that occur in very quick visual sequence. For example, imagine analyzing clues in a surveillance tape that you’re playing through the computer. You can draw attention to an interesting on-screen event with the pen tool.

For more information about using SMART Video Player, see page 18.
Typing Directly Into an Application or a Dialog Box

In almost every situation involving a computer, you will eventually need to type text with a keyboard, even if it’s only to input text into a dialog box.

SMART Board software lets you do this at the screen as easily as if you were sitting at your desktop, typing on the keyboard, and without disrupting the flow of your presentation to access an actual keyboard.

SMART Keyboard

Open the SMART Keyboard on the interactive screen and press the virtual keys. When you finish, press the Send button, and the letters that you’ve typed appear in the active application.

Press the **Keyboard** button on the pen tray to open the on-screen keyboard. Drag the SMART Keyboard to a higher spot if you’re typing with 10 fingers.

Use a sans-serif font, such as Arial or Comic Sans, because it’s easier for beginner readers to distinguish the letters.

You can change the views of the keyboard to make your most commonly used functions available. These views include:

- Classic, with its standard QWERTY keyboard layout
- Simple and Simple Caps, with the keys in alphabetical order
- Number Pad, for number input and mathematical equations
- Shortcut, for writing keyboard shortcuts at the interactive screen
- Write, for quick conversion of your handwritten letters

For young students, you might want to show the keyboard keys in alphabetical order instead of using the QWERTY layout. If so, use the Simple view of SMART Keyboard instead of the Classic view.
Handwriting Recognition
You can inject handwritten words into any file or dialog box as typed text. If your active application isn’t Ink Aware, you can insert a handwritten note (that’s converted to typed text) directly into your file. To convert and insert your note, press and hold your note. When the menu appears, select Inject <your note> Here.

In Ink Aware applications, press the Insert as Text button, which appears either in a three-button Aware toolbar or in your application’s toolbar.

In Notebook software, select a handwritten word or a series of grouped words, press the menu arrow in the upper-right corner of the selection rectangle, and select a conversion option.

Typing and Formatting in Notebook Software
Just start typing in Notebook software. Text appears inside a resizable text box, along with a Fonts toolbar that lets you change every aspect of the text, including font, font size and style, justification and bulleted. When you resize the text box, the text inside wraps accordingly.

Making Other Kinds of Notations
Your presentation may be complete, but you may still want to draw the audience’s attention to key points or to simply entertain them with color and animation. For more information on other ways to make notes, read the section on Presenting that starts on page 55.

Floating Tools
You can add geometric shapes to your notes by adding the Shapes button to the Floating Tools. You can customize these buttons so that with one press you can add a star, a circle, a rectangle and more.

You can also add tools that focus the audience’s attention on certain screen areas, such as the Pointer Tool, the Screen Shade and the Spotlight. Or you can add applications such as the Calculator, the SMART Keyboard and the Magnifier to the Floating Tools.
Adding Content into Notebook Software

In other sections of this guide, we discuss how to create and modify objects in Notebook software (Writing and Drawing in Notebook Software on page 24), as well as how to capture information from other sources (Capturing with the Notebook Software Capture Tools on page 39).

In this section, we’ll focus on adding content to your presentation. For example, you can add clip art, templates, images, Flash files, links to files and Internet addresses to your Notebook file.

Using the Gallery

The Gallery consists of several thousand templates, clip art images and Flash files, organized into categories. To access the Gallery, press the Gallery tab at the side of the Notebook software window.

The Gallery is organized into two panes: a list of categories and a contents pane. When you browse through the categories, watch the thumbnail previews in the contents pane. Then drag any thumbnail from the contents pane directly onto your page.
Gallery Categories

The Gallery is organized into three major categories: Education, Professional and My Content.

If you’re a teacher, browse through the extensive Education category, which is further broken down into subject categories for your convenience. The Education category is loaded with clip art, templates and Flash files that you can use as visual aids for teaching a wide variety of topics to classes at all grade levels.

If you’re someone who prepares professional presentations, browse through the templates and tools that are available in the Professional category, including variously lined paper, graph paper, rulers and protractors.

About Page Templates

A page template gives you a way to reuse content on your Notebook pages. There are two types of templates in the Gallery: conventional templates that come with the Gallery, and customized templates that you can make to reuse the content and images on a page you created.

The templates that come with the Gallery, including blank calendar pages, agendas, ruled writing paper, graph paper, and geographical maps, can serve as the background for many different document types. These are conventional templates that help you format and present information in a specific way. The content of these templates stays permanently in the background and can’t be selected or changed.

The templates that you create from your Notebook pages can include text, shapes, imported images, Flash content and digital photos—anything you can place on a Notebook page. When you convert a page into a Gallery template, you are simply making its contents conveniently available for reuse. These templates are not conventional, background templates. In fact, when you open a self-created template, all the objects on the page are just as you created them: selectable and changeable and in the foreground. See Adding Your Own Content to the Gallery on page 32 for more information on creating templates.

NOTE: To make your template behave like a conventional template, select all the objects on the page and select Format > Lock in Place. The objects are protected from accidental change.
Templates are represented in the Gallery as an image of a page with a turned-down corner.

When you drag a template onto the current page, Notebook software creates a new page after your current page and applies the page template to the new page.

Some templates include a Snap To feature. For example, if you add a map template (e.g., Europe) to a page and then drag an associated piece of clip art, such as the United Kingdom, onto the map, the clip art will snap to position if you put it near the proper place on the map.

Adding Your Own Content to the Gallery

To add your own clip art, Flash files and Gallery collections from other Notebook files, click the Add/Import button at the top of the Gallery and select the appropriate command.

Customize the Gallery by adding pictures and text that you’d like to store for later use from just about any source. For example, paste images and text onto a page, and then add the page to the Gallery as a template. To do this, click the Add/Import button and select Add Current Page to Gallery. Your new content is stored in the My Content category.

You can import and export categories from other Notebook files as Gallery collection files (with an .xbc extension). A collection file is simply the contents of an entire category saved to a single file. Click the Add/Import button and select Import Collection File to import collection files from other Notebook files.

To export a category as a collection file, just click the category’s menu arrow button and select Export as Collection File.
Organizing Your Gallery Content

You can freely reorganize the contents of the Gallery by clicking on a category and dragging it to another category folder, just as you would rearrange files and folders in Windows Explorer.

As you add more images and templates to the Gallery, you may need to change the file structure. It’s easy to add new subcategories: Just click the Add/Import button and select Add New Subcategory. A text box appears in the list of categories, below the selected category. Enter the name of the new subcategory, and then add templates, images and Flash files to it.

My Content is a category in which you can place your own clip art, Flash files and templates that you use often. You can only add content to the My Content category.

NOTE: If you try to access the Gallery on a shared resource drive, you'll find that it’s locked. This means that you can neither add nor remove any of the items from the Professional and Education categories. However, you can still make changes to the My Content category.

For more detailed information on using the Gallery, see the Help Center.

Adding Web Links and File Attachments

Navigating to files or websites during a presentation can be awkward and distracting: your presentation can lose its momentum, and participants and students can lose their focus.

Instead, add files, shortcuts to files or the Web addresses into the Attachments tab of Notebook software before your session. Then, during the session, you can open files or sites in no more time than it takes to press on the screen. Everyone remains on track and no time is wasted.

Click the Attachments tab and then click the Import button (located at the bottom of the tab) to browse to a website, file or file shortcut. Then, when your presentation is in progress, press the Attachments tab and then press on the file, file shortcut or Web link. The target file or website will immediately appear.

If file size is an issue, import a file shortcut to the Attachments tab instead of a file copy. Unlike a file copy, a shortcut will add very little size to the
total size of your Notebook file. However, a certain amount of compression does occur when you import a file copy into the Attachments tab, so the file copy you attach will not be as large as the original file.

**NOTE:** If you add a file shortcut to the Attachments tab, make sure that the file is available when you give your presentation. For example, don’t include a shortcut to a file located on your hard drive if you intend to access the file from a network computer during your presentation. Put the file on the network first, and then attach a shortcut to it.

### Adding Images and Flash Files

You may want to add images or Flash files to your Notebook presentation from sources other than the Gallery collections. Notebook software also supports .bmp, .jpg, .pcx, .png, .tga, .gif, animated .gif, .tif and .wmf file formats.

Just select **Picture/Template > From File** from the **Insert** menu, and browse to the image you want to add. If you prefer, just copy and paste the images.

To import a Flash file, select **Flash File** from the **Insert** menu and browse to the file that you want to add to the page. If this is a Flash file that you want to have on hand for future use, add it to your Gallery collection, as described in *Adding Your Own Content to the Gallery* on page 32. During your presentation, you can control the playback of a Flash object by pressing that object’s menu arrow and selecting from the menu that appears.
You can write over a Flash file, as long as that file accepts writing, and you can use the pen to press buttons or activate components of a Flash file. If you write a note in an area of the Flash file that recognizes handwriting, your note will be converted to text. You can also erase the notes that you write over a Flash file.

Adding Scanned Images

If you have a scanner connected to your computer, you can scan pictures directly into a Notebook file. Just select **Picture from Scanner** from the **Insert** menu, select your scanner from the list, and press the **Scan** button. You can move, size and rotate the picture as you would any other object.

**NOTE:** The scanner's driver and image-editing software must already be installed on your computer. Notebook software can't use your scanner without this driver and software.

Other Ways of Adding Content to a Notebook Page

• While you’re in other applications, drag selected text or images onto the minimized Notebook icon on the Windows tool bar. Notebook software will open and you can continue dragging the selection directly onto the Notebook page.

• Use the SMART Notebook Print Capture tool that’s described on page 39. You can import an image of all or some pages in a file from any other source to the end of the current Notebook file, with the original page breaks and formatting preserved.

• Use Notebook software’s Screen Capture tools, described on page 39, to add screen captured images from any other source on your computer or the Internet. Remember to respect copyrights!

Make interactive learning fun by letting your students handwritten and interact with Flash files. Check www.EDCompass.com for more content and lesson activities.
Erasing

Mistakes are a part of learning. Everyone makes them, and no matter how carefully you’ve prepared your material, your pen may slip, you may spell something wrong or you may write down the wrong word.

With your SMART interactive product, correcting your error can still impress your audience. Because the eraser tools in SMART Board software are so intuitive, you can effortlessly amend your notes with minimal disruption to the flow of your presentation.

Erasing Your Note

Use the physical eraser to remove digital ink from the interactive screen. At the interactive whiteboard, pick up the eraser and wipe it across the screen. At the interactive pen display, push the Eraser button and drag the pen across the screen.

TIP

Depending on your writing, the eraser may be too large or too small. You can change the size of the screen area that it erases by changing its settings. To do this, select Control Panel > Pen Tray Settings.

To erase small areas, pick up the pen tray eraser and then touch the interactive whiteboard with your fingertip.

Floating Tools

You can use the eraser from the Floating Tools to erase freehand notes.

To quickly remove your notes from the screen, press the Undo button on the Floating Tools toolbar. When you press this button, you remove or return the last transparency layer to your screen. So even if you’ve completed other actions at the interactive screen, you can restore the notes that you wrote earlier.
Notebook Software

You can fully or partially erase any object that you create freehand on a Notebook page using the pen tray eraser or the Eraser button on the toolbar.

To remove other objects, including typewritten text, shapes, imported pictures or Flash objects, select the object and click the Delete toolbar button.

Quick Erasing of Large Areas

To clear a large area of electronic ink, use the physical eraser to encircle the area, and then tap once inside. All freehand annotations inside that circle disappear.

This technique is called the “circle and tap” method of erasing.

Restoring Lost Notes

When you’re presenting, your notes will disappear if you return to left-click mode (by returning the pen in the pen tray or clicking the Left-Click button) and then touch the interactive screen.

To prevent this inadvertent loss, SMART Board software makes it easy for you to retrieve any note that you’ve written by keeping a thumbnail image of your notes in the lower-right corner of the screen for approximately five seconds. Press this thumbnail to restore the notes.

Alternatively, you can continue to present without restoring the note and the thumbnail image fades away.

Floating Tools

Don’t worry if you want to retrieve a note after its thumbnail image is gone. You can still recover it by opening the Floating Tools and pressing the Undo button.

Notebook Software

To recover your erased or deleted objects in Notebook software, press the Undo button in the toolbar.
Capturing and Saving

Because any note you make may be critical, SMART Board software makes it easy for you to save each one.

Don’t lose those spontaneous ideas that emerge in meetings. Simply write them on the screen and capture them for further examination and discussion.

You can use the large whiteboard space of Notebook software to keep your notes.

Your capture options differ, depending on whether the active application is Ink Aware.

You can capture a specific area, a window or the entire screen from any non-Ink Aware source on your computer using either the Floating Tools of SMART Board software or Notebook software’s Screen Capture toolbar. Both features accomplish the same function: capturing the image onto a Notebook page.

In Ink Aware applications, such as Microsoft Word, Excel and PowerPoint, you can integrate your note with the active application or capture it to Notebook software. If you capture a note that you made over an Ink Aware application to Notebook software, the image of the application is one object, and the note becomes another object on top of the application image. You can work with these images separately.

Don’t lose the impromptu sketch on the screen of your next award-winning product. Capture it to Notebook software, where you can add notes to it or copy it again. You can save this Notebook file to the company network, post it to the intranet or e-mail it in various formats.
Capturing with Floating Tools Screen Capture Buttons

When you write over an application that’s not Ink Aware, the Floating Tools appear in collapsed view, with only the Area Capture and Undo buttons visible. Press the Area Capture button and then drag across the screen to immediately capture what you’ve written, without fumbling through other software tools. (If you press this button and then click once on the screen, a capture of your entire screen appears on a Notebook page.) The Undo button is available for quickly restoring annotations that you may have accidentally deleted.

The image you capture is made up of your notes and the underlying application. By default, the newly captured image appears on a new Notebook page, so if you’re already working in Notebook software, the image won’t interfere with existing content.

When you expand the default Floating Tools toolbar (by pressing the circular arrow button), you can add the Window Capture or Screen Capture buttons to the Floating Tools. To do this, press the More button. (See How To > Save > Capture a Note with Floating Tools in the SMART Board Software Help Center for details.)

Capturing with the Notebook Software Capture Tools

You can open the Capture toolbar from the Notebook software View menu. This three-button toolbar appears and remains open over any active application or Web browser, allowing you to capture an image from any source and have it automatically placed in a new (or the current) page of Notebook software.

Using SMART Notebook Print Capture

If you can print text from an application, you can add that text to your Notebook page.
SMART Notebook Print Capture is a convenient way to append entire multi-page files from other Windows applications to the end of the current Notebook file. You can immediately view all the pages of the imported file—an image of one printed page per Notebook page—with the original page breaks and formatting preserved.

When you install Notebook software, SMART Notebook Print Capture is installed as a printer driver. This means that this printer will appear in the list of printers and printer drivers in other Windows applications. While you’re in that application, select Print. When the Print dialog box appears, select SMART Notebook Print Capture as the printer. This printer driver works like any other printer, except its output is captured to a Notebook file rather than printed on paper.

For example, you can print an entire Microsoft Word document using the SMART Notebook Print Capture as the printer, and it will appear identically in Notebook software, with its original page breaks, text and paragraph formatting preserved.

**Inserting Your Notes into Microsoft Word and Excel Files**

When you’re working in Microsoft Word or Excel, you can add your notes directly to the page. You can then keep these notes as a picture, or you can convert them to typed text.

When you write on the interactive screen, the SMART Aware toolbar appears. If you have version 2000 or later of Word or Excel software, this toolbar appears with the application’s other toolbars. If you have an earlier version, a floating toolbar appears. On either toolbar, press the **Insert as Shape** button to keep your note as a picture, or press the **Insert as Text** button to insert the note as typed text.

If you prefer not to alter the active file, you can capture your note (and an image of the underlying application) into the current Notebook file. These are inserted as two separate objects on the Notebook page.
Inserting Your Notes into PowerPoint Software

SMART interactive products are specially designed to enhance your PowerPoint presentations. See page 62 for information on presenting with PowerPoint software. During the presentation, you can write notes over the slides, and then save them in a few different ways.

The least obtrusive method of saving your notes is to save them with each slide when you save your PowerPoint file. If you prefer to keep your notes separate from your slide content, you can capture them to the current Notebook file instead of your PowerPoint file. To do this, press the Menu button on the PowerPoint toolbar and select Capture to Notebook.

Inserting Your Notes into Other Ink Aware Applications

You can capture your notes as typed text in any application that accepts text by injecting them into the active file at the cursor location. Press the note and keep holding it until a menu appears. If you select the suggested conversion of the word, that word appears in your active application.

Capturing Your Work as a Video

If you want a record of your actions at the interactive screen, use SMART Recorder. This tool creates a video file, and if you have a microphone connected, it automatically saves the audio as well, so you can narrate your actions at the computer.

Have a student open a rough draft of their work on the interactive product. Work through the editing process together, making changes in the file as you go.

Make your brainstorming meetings a true collaboration with your coworkers. Write their comments on the open slides (or add a new blank slide to write into) and save these notes with each slide.
You can record the entire screen, a specific rectangular area or a specific window. Then you can post this video file on a network or a website to make it available for others, or you can e-mail it (see page 50). The length of your recording and its frame rate are shown on the title bar of SMART Recorder.

You can set the options for your recording by selecting the **Menu > Options**. For example, you can set a higher sound and video quality. However, this will increase the file size, which is a concern if your computer has limited disk space, if you intend to e-mail the file or if you want to post it on a website. Also, you can change the default save directory and the location of the temporary files that are created when you record the movie. At the same time, you can prevent the loss of your recording by setting SMART Recorder to warn you when disk space runs low.

**Saving the Notes You Make Over Videos**

You can save the notes that you make over the videos that you play with SMART Video Player. To save the notes and a still image of the underlying video to Notebook software, take a screen capture using the **Capture the Image** button in the **SMART Video Player** window.

**Saving in Other Formats**

After you create your content in Notebook software, you can export your document in HTML, as a PDF or in a variety of image formats. See page 50 for more information.

**Saving Content from a Data or Videoconference**

If you’re watching a remote presentation from your computer and you want to keep some of the material shown, use the screen capture tools to do so. These tools are available from the Floating Tools (see page 39). For more information on conferences, see page 63.
Changing How the Software Works for You

Because it’s a productivity tool, you can modify SMART Board software to change the way you create presentations and the way you deliver them. As a result, you can create better presentations in less time.

Essentially, most options in SMART Board software are changeable, including the views on the interactive screen, how digital ink appears and more. Any changes that you make to SMART Board software are saved with your logon ID for the computer, so the next time you log on, you’ll see your custom settings. For details on how to change specific options, search the How To topics of the Help Center.

Changing the Way You Access Tools

Place the interactive tools on the screen so everyone using the SMART interactive product can reach the toolbars. You can move items around on the screen, and in some cases, you can lock them into place.

Start Center

With the Start Center, you can access the interactive tools and the applications that you use frequently. You can easily add buttons for the tools that you use most often and remove buttons for tools that you don’t use. The applications you add can be SMART programs or any other program that you use, such as Microsoft Word, Excel, PowerPoint or your Web browser. The added application appears as a button containing the application icon.

To add a button for an application or a tool, press the More button at the bottom of the Start Center and select Customize Start Center. Then press the Browse button to add applications, or press the Add button to choose from a list of available tools. Read How To > Add an Application to the Start Center in the Help Center for more details.

TIP

You can drag files as well as applications from your desktop or Windows Explorer directly onto the Start Center. The added file or application appears as a button with the application icon.
For example, you can add a button for the Windows Calculator to the Start Center. Then press this button to open it.

To work with your younger students at the interactive whiteboard, keep the Start Center near the bottom of the interactive screen, so they can reach it.

**Floating Tools**

Add buttons to the toolbar for tools that you may use often, or remove buttons for tools that you don’t use. There are many tools available in addition to those you see on the default tool set. To view these other tools, click the More button and select **Customize Floating Tools**. The available tools are listed in the Available Tools list.

If you prefer to work with a smaller version of the Floating Tools, you can collapse it by pressing the circular Arrow button on the side of the toolbar. This small version still includes the Area Capture button, so you can capture anything you write to Notebook software, and the Undo button, so you can retrieve any note that you accidentally remove.

You can customize the appearance of the Floating Tools by making the toolbar more or less transparent and working with smaller buttons. You can also select one of the Tool Sets, which include a number of default tools and settings. To do this, press More > Customize Floating Tools. On the Customize Floating Tools dialog box, press the Restore Default Toolbar button, and select either the Classic or the Creative tool set.

You can also change the settings for individual tools. To do this, either double-click or right-click a tool and select your new settings. Or press the More button and select **Customize This Tool**.

**SMART Board Control Panel**

You can change many SMART Board software settings by opening the SMART Board Control Panel.
When you press **SMART Board Settings** on the SMART Board Control Panel, information about your interactive product and SMART Board software settings appears, and you can access other settings. Or you can press **Pen Tray Settings** to change the function of the pen tray pens or the **Colored Ink** buttons.

Many other options are available. For example, if you want more precise touch control, you can change the default orientation precision. Or, if your computer's desktop is stretched across more than one SMART product, you can tell SMART Board software how your products are arranged. These procedures are detailed in the Help Center, which you can access by opening the SMART Board Control Panel and pressing the **Help** button.
Your SMART interactive product is an input device for your computer, and SMART Board software has built-in features (like the Mouse Settings) that make it easier to work with applications. Read SMART Board Control Panel > Mouse Settings in the Help Center to learn about these features.

**Adjusting the Notebook Interface**

The Notebook interface is flexible enough to suit a variety of needs.

**Using the Full Screen View**

When you’re presenting to a group, use the Full Screen view of Notebook software. In this view, the title bar, command menu and Windows task bar disappear, giving you the greatest page area possible, with the toolbar and tabs easily available.

To open the Full Screen view, press the Full Screen button. To return to the Normal view, press it again.

**Relocating the Toolbar**

You can easily access a variety of commands on the Notebook software toolbar. If you need to, you can move this toolbar to the bottom of the screen, making it much more accessible to children and shorter adults.

To move the toolbar, press the drag handle on the far left of the toolbar, and drag the toolbar to the bottom (or return it to the top) of the window. Don’t worry about aligning the toolbar. If you drag it to the general vicinity and remove your finger, it will snap into place.

**Relocating, Expanding and Keeping the Side Tabs in View**

By default, there are three tabs at the right side of the Notebook Software window: the Page Sorter, Gallery and Attachments tabs. These tabs disappear from view with your first click in the page area.
If you’d rather move the tabs to the left side of the window, click the Circular Arrow button at the bottom of the tabs. To keep the tabs in view when you’re working on a page, clear the **Auto-hide** check box at the bottom of the tabs.

**NOTE:** These settings are remembered and restored each time you open Notebook software.

**Expanding the Page Sorter**

You can make the Page Sorter larger (even taking up the entire page area) by dragging its border. Of course, this has the effect of shrinking the current page area, but if you’re rearranging pages, this is an optimal view.

**Changing Your View of a Notebook Page**

Notebook software lets you zoom in to get a close-up view of the page or zoom out to see more of the page at a smaller size. Notebook software provides zoom options between 50 and 300 percent.

The **Entire Page** option zooms out to fit the entire page on your display.

The **Page Width** option zooms in or out so the page occupies the entire width of your display, while allowing you to extend the page by clicking the **Extend Page** link at the bottom of the page.
Changing the Appearance of Digital Ink

To create eye-catching notes, customize the ink for your product’s interactive tools (pens for interactive whiteboards and pen tool buttons for interactive lecterns), and for the Floating Tools.

For example, you can change:
- the ink color
- the thickness (width) and style (such as solid, dotted or dashed)
- the style of the line ends
- the transparency
- fill properties of shapes

Changing the Ink Settings for the Physical Tools

You can change the behavior of each pen tray pen by opening the SMART Board Control Panel and pressing **Pen Tray Settings**. Select the pen you want to change and set the new properties in the **Customize Pen** dialog box.

You can customize the **Colored Ink** pen tool buttons by opening the SMART Board Control Panel and pressing **Pen Tray Settings**. Select the pen for the **Colored Ink** button you want to change and set the new properties in the **Customize Pen** dialog box.

Changing the Ink Settings for the Floating Tools

You can customize how each pen tool from the Floating Tools behaves by double-clicking or right-clicking its toolbar button and changing its settings in the **Configure Tool** dialog box.

**TIP**

To choose from a few differently colored pens in the Floating Tools, click the **More** button, select **Customize Floating Tools** and add more **Pen** buttons. Then customize each pen with the settings that you want.
Changing the Ink Settings in Notebook Software

You can customize the writing and drawing tools in Notebook software. To change the properties of the digital ink that comes from the pen, press the menu arrow beside the Pen button. Select Customize and the Customize Pens and Highlighters dialog box appears. Select your new settings and press OK.

If you want to change the digital ink settings for other tools, press that tool’s menu arrow and select Customize. You’ll see the Customize dialog box for that tool. Make your changes and press OK.

Recording a Different Screen Area

SMART Recorder can record a portion of your screen, a specific window or the entire screen. To select an area or window to record, press the Record button’s menu arrow.

Changing the Way You Use PowerPoint Software

Some meetings are collaborative efforts that further a PowerPoint slide show work-in-progress by adding notes to the slides. With SMART Board software, you can save these notes with each slide or you can save them to a Notebook file. Whichever method you select, you can make your notes without interrupting the meeting flow or running the risk of losing important points.

For more presentation tips and information, see page 55.
Sharing

After you collaborate using your SMART interactive product, you may want to share the results of your meeting. There are many ways to do this with SMART Board software. The method that you use depends on what you’re sharing and the format your recipients require.

Sharing a Recording

If you want others to review your entire meeting or lesson at a later date, you can record it. With a microphone connected to your computer, you can also record the narration (audio). (See page 41 for more information.)

Some teachers have recorded the solution to complex mathematical equations using SMART Recorder, and then posted the recording on a school website where students can review it. This allows each student to go through the steps, pausing or rewinding when they need to, so they can learn at their own pace and better understand how the solution was reached.

You'll find ideas from other teachers about using SMART products at www.EDCompass.com.

You can also e-mail a SMART Recorder file to others. Anyone with Windows Media® player can view your file.

If you want to share a compressed, higher quality video with others who have SMART Board software, you can record your on-screen actions using the SMART AVI format, which can be viewed using SMART Video Player. Press **Menu > Share Recording** to open a wizard that creates a compact executable file that you can send to others.

Saving Notebook Files in Different Formats

Make the material you create in Notebook software accessible to others who don’t have Notebook software installed on their computer. You can save it in HTML, as a PDF document or as a series of image files.
Notebook software can automatically export your file at a specific interval or whenever you open a different page. See the Notebook Help for detailed information on exporting your file in the formats listed previously.

**Sharing an Image of Your Notes or Screen**

You can capture a picture of any screen and share it with others using the tools available in Notebook software (see page 39). When you write on the screen, the Floating Tools appear or you can launch the capture tools from Notebook software. To do quick area captures or window captures, add these buttons to the Floating Tools toolbar.

You can also print an image of your screen complete with your handwritten notes by using the **Print Screen** button that you add to the Floating Tools (see page 53 for more details).

**Sharing Files on Your Laptop**

You can share files that are on your laptop computer in a meeting by connecting over the network to the SMART product using LinQ software. You must install this application on your laptop and enable connections through the Mobile and Wireless Device Settings on the computer that’s connected to the interactive product. Both computers must be connected to the same network.

When you use LinQ software, you don’t have to install SMART Board software on your laptop and you don’t have to connect any wires. LinQ software establishes a link with the interactive product through the network, letting you use the interactive tools at the SMART product while running a file on your computer.

You can install LinQ software on your laptop from the SMART Board software CD or from www.smarttech.com/support/software/linq.asp. There, you’ll also find a PDF file of the user’s guide with more information on using this application.

Another way to share files that you have on a laptop computer is to connect the laptop directly to the interactive product. For example, if...
you’re using a front projection series 600 interactive whiteboard, you can disconnect the interactive whiteboard’s USB cable from the computer and plug it into your laptop. Without installing SMART Board software, you have instant touch control of the interactive whiteboard. The interactive whiteboard is already oriented for you. However, you can’t use the interactive tools, such as the pen tray pens, unless you install SMART Board software.

NOTE: If you’re using the interactive product without installing SMART Board software, the LED on the product will blink continuously. This is normal.

If many laptop users access the interactive whiteboard in your room, you may want to provide a serial cable (null modem) that’s connected to a serial port on the interactive whiteboard’s computer and a video cable that’s connected to the projector. Then set up a Display Control and enable the Guest Laptop switch that’s available from the Display Control’s settings window. (Read the topics in SMART Board Control Panel > Display Controls and Bulb Saver in the Help Center for specific setup instructions.)

After you’ve set up SMART Board software and provided these cables, any laptop user can connect to the interactive whiteboard and to the projector to display the laptop’s desktop. To switch to the laptop’s image output, use the projector’s remote control to change the input source. The result is a quick setup time and immediate access to the interactive whiteboard from the laptop. To use all the features on the interactive whiteboard, you should install SMART Board software on the laptop.

**Sending Your Notes by E-Mail**

If you capture your notes in Notebook software, you can send the file with an e-mail message. From the File menu, select Send To > Mail Recipient. Notebook software launches your default e-mail program and creates a new message with the file attached.

**Printing Your Notes**

You can print every page or individual pages from Notebook software, just as you would for any standard Windows application. You can also print your file “handout” style, with multiple Notebook pages appearing on a single sheet of paper. You can also select how many Notebook pages appear on each printed page.
You can prepare lesson activities and handouts ahead of time by using Notebook software. If you make notes during the class that are relevant to the handouts, print the pertinent page(s) from your Notebook file.

You can also print an image of your computer screen, complete with any notes written on it. To do this, add the Print Screen button to the Floating Tools (see page 44) and then press that button to send the image to the computer’s default printer.

Sharing Content from Other Applications

With SMART Board software, you can add files from many sources and share them with your audience. No matter what application you’re using, you can write notes over the file and then quickly convert these notes into typed text that’s inserted at the cursor location. You can use this feature to enter text in a Save As dialog box or to enter an Internet address in your Web browser.

For quick access to a specific file or a website from a Notebook page, you can link an object on the page. When you press this link, the file or the website opens immediately.

You can add buttons to the Start Center for tools and applications that you commonly use. Then you can press these buttons to access the file or program. To add another tool to the Start Center, press More > Customize Start Center. In the Customize Start Center dialog box, select or browse to a tool. For more detailed instructions, read How To > Add an Application to the Start Center in the Help Center.
You can add text into your Notebook file from other applications by printing from that application with the SMART Notebook Print Capture printer. See page 39 for more details on this feature.

When you use other applications, you can insert the notes that you write on the interactive screen into that file (see page 28).

If your students are using computers that are connected to a network, consider SynchronEyes software. This computer lab software makes it easy for teachers and students to share a desktop on the interactive screen so the entire class can see it. With this software, you can also monitor and control student computers from your own desktop or from the interactive product.

For purchasing details or to download a trial version, visit www.smarttech.com.
Presenting

SMART interactive products add a “wow” to every presentation. Whether your audience is in the same room or watching your screen over the Internet, a presentation is more enjoyable for everyone when you write on the interactive screen.

Increase your presentation’s visual impact by moving items around the screen with your finger. The ease with which you do this will impress your audience.

A variety of hardware and software features help you deliver your presentation. For example, writing with a pen can be a more intuitive way to interact with the computer screen. You can use software tools like the Magnifier to help the audience see your content.

Read this section for suggestions on using the SMART Board tools and Notebook software to deliver professional-level presentations.

Minimize meeting setup time by using your laptop to both prepare and deliver your presentation. You can share your laptop file to the interactive product if you install LinQ software. At the presentation computer, ensure the Mobile and Wireless Device setting has been enabled and that the two computers are on the same network. (See page 51 for more details on LinQ software.)

Because your file is still on your laptop, you can navigate to its familiar location, and still use all the interactive tools on the interactive product.
Preparing Your Presentation

Use the many ideas previously described in this guide and in the Help Center to create and gather content for your presentation. For example, enliven your presentation or meeting by adding video or audio clips and by accessing relevant websites. You can also display images and information from peripheral devices that are connected to your computer, such as a document camera or a scanner. If you’re using a video capture card, you can also show video from a VCR or DVD player (see page 18).

Use Notebook software to organize your material, or save it in another application that you can access with the computer that’s connected to the SMART product. You can store your file on a network drive, a disk or a USB storage device that you would insert into the presentation computer.

Delivering Your Presentation

SMART Board software is ideal for delivering and recording the ideas and information in a meeting. For example, Notebook pages are ideal for recording action items, sales notes, status updates or any suggestions that emerge from your discussions. Use Notebook software in a brainstorming meeting to record ideas as they occur. If you’re delivering a lesson or a lecture, you can engage your audience with your smooth delivery on the interactive technology.

To demonstrate software to a group, show it on the large screen of the SMART Board interactive whiteboard. You can activate program components with your finger or use the pen tray tools to circle unique features, all while remaining in front of your audience.

In code reviews, you can jot down comments from your peers and save your notes and an image of the screen in a Notebook file. You can keep this record of the comments on the network or e-mail the file to the applicable developers.

You can save time and paper by taking meeting notes right at the interactive screen. By displaying these notes in front of everyone, you can reduce ambiguity and minimize misinterpretations. After the meeting, you can print them as a handout or e-mail them to participants as an
attachment. (See page 52 for information on sending an e-mail message and printing pages.)

If you’re discussing a document in your meeting, you can add it to your Notebook file. The SMART Notebook Print Capture printer from SMART Board software will print any document into Notebook software, with all the original formatting and page breaks intact. You can also use the Screen Capture tools to insert content into your Notebook file, or you can insert images from a scanner or digital camera. For more information, see Capturing with the Notebook Software Capture Tools, on page 39.

Avoid navigating to files or websites during a presentation. Use the Attachments tab of Notebook to attach the file or website address beforehand. Then press the tab and double-press the stored file or link. For further details, turn to page 33.

When you’ve delivered the content and made your notes, you can export the Notebook file in a variety of formats, including PDF, HTML or as a series of images.

Consider using SMART Ideas® concept-mapping software to organize lessons and help students create a graphic representation of their knowledge. Studies suggest that concept maps, images and graphics assist visual learners express and understand ideas. On an interactive product, your students can actively discover the relationships between ideas by moving objects around, thereby deepening their understanding of many concepts.

Controlling What Your Audience Sees

When you’re presenting, take a moment to consider what the audience sees. You should maximize applications to take advantage of the large screen. Full screen views, like the one available in Notebook software, are also easier for audiences to see.

NOTE: If you often use a particular presentation tool or application, you might want to add that tool to the Start Center. To do this, open the Start Center, press the More button (at the bottom) and select Customize Start Center.
The Magnifier

If there’s a detail on the screen that you want everyone to see, use the Magnifier to enlarge it. Press the SMART Board icon in the system tray, and then select Other SMART Tools > Magnifier. Drag the smaller window over the screen area, and view the magnified results in the larger window. Press the Close button in the larger window to close the Magnifier.

The Screen Shade

Use the Screen Shade to hide content on the screen until you’re ready to reveal it.

Press the SMART Board icon in the system tray, and select Other SMART Tools > Screen Shade. The entire screen is then covered by a shade. Handles at the top, bottom and both sides of the shade allow you to drag it to selectively reveal the screen contents from any direction. To remove the Screen Shade, press the Close button in its upper-right corner.

The Spotlight

Use the Spotlight to illuminate a portion of the screen. Press the SMART Board icon in the system tray, and then select Other SMART Tools > Spotlight.

Like a theatrical spotlight that illuminates the principal actor on stage, this tool reveals only a specific area of your screen, while the rest of the screen is dimmed or completely hidden. As a result, your audience focuses on what’s important.

You can use the spotlight to pique the audience’s curiosity, and when you’re ready, you can enlarge the spotlit area to reveal more information. To do this, drag the spotlight around the screen, and resize or rotate it until it’s positioned just the way you want.

With the spotlight on, you can write notes and activate screen components inside the spotlit area. You can also change the shape of the spotlight and the transparency of the shade that covers the non-spotlit area.
Screen Pointer and Shape Tools in the Floating Tools

If the screen you’re displaying contains a lot of information, use the screen pointer to direct the audience’s attention. Simply drag this pointer from the Floating Tools onto the screen. As you drag it, it changes its orientation and position.

Another option is to create a semi-transparent rectangle with the Floating Tools. Like dragging a highlighter over important sections of the screen, you can click the Rectangle button on the toolbar and touch the screen to highlight important areas.

NOTE: Neither the Screen Pointer nor the Shape tools are part of the default Floating Tools. To add these tools, see page 44.

LinQ Software

If your meeting participants bring their presentations on their own laptops, have them install LinQ software so they can connect their laptop to the interactive product’s computer. When it’s their turn to present, they can share their desktop and show the file on the interactive screen. (See page 51 for more information on LinQ software.)
Capturing, Recording and Saving Your Presentation

As you deliver your presentation, you can use the SMART Board software tools to save your notes or the entire presentation. Use the suggestions here or see page 38 for more details on saving notes and content.

The Screen Capture Tools

You can capture important information and notes of suggestions made by the audience into Notebook software with the screen capture tools.

SMART Recorder

Create a record of everything that you do on the interactive screen by recording your actions and your words as a video file so you won’t miss a single detail. You’ll need a microphone to record your speech.

Let your meeting or training session attendees review the session (or portions of it) whenever they want. Use SMART Recorder to save a copy of the session, and then post this file on the intranet or make it available to participants. This file can help participants refresh their memories, or you can use it to train others who missed the original course.

Presenting Your Notebook File

After you create your Notebook software presentation, press the Full Screen button on the toolbar to deliver it in Full Screen view. This view gives you the greatest page area possible, while still making the toolbar and tabs easily available. The title bar, command menu and Windows taskbar disappear in this view.

To use LinQ software, your guest presenter must have installed the application (from the SMART Board software CD or from www.smarttech.com/support/software/linq.asp) and must have access to your network. Then they can share their laptop desktops to show the presentation file on the interactive product. This allows the presenter to use the interactive tools without installing SMART Board software.
Other handy presentation features include:

- the Screen Shade, which focuses your audience’s attention. Press the Screen Shade button on the toolbar to insert a shade over the page and gradually drag it back to reveal the text and graphics underneath. Handles appear at the top, bottom and both sides of the shade, so you can selectively reveal the page contents from any direction.

- the Attachments tab, on which you can store files, shortcuts to files and Internet addresses. A single press on a link in this tab opens a file or a website, so you have immediate access to external information during your presentation.

Navigating through Your Notebook Presentation

In any view, you can navigate through your Notebook software presentation by pressing:

- the Next Page button on the pen tray or the function buttons on the Sympodium interactive pen display

- the Next Page or Previous Page buttons on the Notebook software toolbar

- any Page Sorter thumbnail to go to the corresponding page

- the RIGHT ARROW or LEFT ARROW keys on your keyboard

Using the Physical Buttons

You can change the function of a physical button on your interactive product so you can use it to navigate during your presentation. For example, configure a pen tray button to advance to the next page in your Notebook file.

If you use your interactive product mainly for delivering presentations, you can configure a button to return to the previous slide. See How To > Change Button Behavior in the Help Center.
Using PowerPoint Software

SMART Board software has been optimized for use with PowerPoint software so that your presentation is smooth and professional. Even if you aren’t familiar with all the interactive features of SMART products, the intuitive tools will help you to deliver your slides with little or no training on the interactive product.

You should show your presentation in the Slide Show view, which maximizes the display area of the screen. Navigate through your presentation by pressing the interactive surface, so you can deliver your content without interruptions.

**TIPS**

To advance your presentation by one slide, press twice on the screen, making the second press to the right of the first.

To reverse your presentation by one slide, press twice on the screen, making the second press to the left of the first.

You can also use the gestures option to right-click or scroll. See Tips for Using DViT Technology on page 16 for details on this feature of SMART Board software.

To keep the interest of your audience, write over your slides. If you prefer, you can add a blank slide to accept your notes. Simply press the middle button on the Slide Show toolbar and select that option. After you make these notes, SMART Board software gives you a few options for saving them. These options are detailed in the next section.

Highlight key points with a large rectangle that has a semi-transparent, yellow fill. Use the Rectangle tool on the Floating Tools toolbar to do this.

When you open your slide show, the Slide Show toolbar appears. You can use this toolbar to access many options, including print and save options. For complete details, refer to the Help Center.
Saving the Notes That You Make over PowerPoint Slides

As you deliver your PowerPoint presentation, you may want to preserve the notes that you write over the slides. You can configure SMART Board software to save these notes with the .ppt file or to save the notes and an image of the underlying slide to Notebook software.

**TIP**

If you know that you'll want to keep any notes that you make, configure SMART Board software to save all the notes at the end of the slide show. This minimizes interruptions to the flow of your delivery, while keeping all changes and notes that you make on the pertinent slides.

However, this option isn’t available if you’re using a read-only PowerPoint viewer program.

Controlling What the Audience Sees in a Presentation

SMART Board software lets you control what’s displayed on the screen during your PowerPoint presentation. Your options include using the Screen Shade and the Spotlight features. See page 58 for details.

Alternatively, you can temporarily divert attention away from the screen by using the Black Screen effect, which hides the entire screen contents from view. This option, which is available from the menu button on the Slide Show toolbar (PowerPoint Commands > Black/Unblack Screen), forces your audience to stop viewing the slide contents.

Other Ways to Present

You can present your file on the interactive whiteboard using LinQ software on your laptop or using Bridgit software as part of a data conference or videoconference. Both applications make available all the tools of SMART Board software.

**TIP**

Deliver distance education through a data conference and a conference telephone call. Have your students connect using conferencing software, and then you can share your screen, highlight information on the screen and write notes to clarify or answer questions.
**LinQ software**

If your meeting participants in the same room as the interactive product have laptops that are connected to the same network as the interactive product, you can activate the Mobile and Wireless Device settings on the computer that's attached to the interactive product. Each laptop user must install LinQ software (from the SMART Board software CD or from www.smarttech.com/support/software/linq.asp), so they can communicate with the interactive product. See page 51 for more details.

**Bridgit Software**

Although it's not a component of SMART Board software, Bridgit software is a powerful yet simple tool from SMART Technologies for setting up data conferences and sharing your computer desktop with others.

> Get effective feedback from clients by showing them your ideas and your progress right from your screen in real time using Bridgit software, without the bother of scheduling sessions.

Each meeting participant can write notes over the desktop and highlight information. You can share your webcam with other participants and view their webcams as well. You can also password-protect your conferences to keep them secure.

**NetMeeting® Software**

SMART Board software is fully integrated with NetMeeting software. All sites can view your notes, and you can save the notes that you write on the Whiteboard component of that software with the NetMeeting file.

For more information on using NetMeeting with SMART Board software, read the related SMART Board Software Help Center topics.
Special Situations

SMART Board software is versatile enough that you can install your SMART products in any configuration and then set up the software to complement the installation.

Connecting Multiple SMART Interactive Products

You can connect more than one SMART interactive product to one computer. For example, you can have a Sympodium interactive lectern and a SMART Board interactive whiteboard connected to one computer, while still having touch control of a file at either product, and still being able to write, draw and erase from either location.

If you’re using more than one front projection SMART Board interactive whiteboard, you’ll need a projector for each unit.

After you set up your equipment, take a moment to configure SMART Board software, as described in the next few paragraphs.

First, decide how you want the displays to work together. You can display the same desktop on all products, which allows people in various locations to see the same image. To achieve this effect, you can daisy chain the projectors or use a distribution amplifier to send the computer’s video signal to more than one display (or projector).

Or you can display different views of the same desktop across the interactive products. With this option, you have the flexibility of opening one window on each screen, or splitting one application across multiple screens. To set this up, you must send the video signal from the computer to each display (or projector). To do this, your setup must include one of the following:

• a separate video card for each projector or each display
• a video card that splits the video signal and sends it to multiple displays or that accepts connections from multiple sources
• a video distribution amplifier between the computer and the projectors
If you’re stretching your computer’s desktop across more than one interactive screen and you’re using an older operating system, you must tell SMART Board software how your products are arranged. To do this, open the SMART Board Control Panel, press SMART Board Settings, and select Arrange Video Output. Depending on your setup, you may need to change the computer’s display settings. For more information, read the documentation for your video card.

If your meeting room has two SMART Board interactive whiteboards side by side, you can work on one application across the width of both screens.

Or you can split your desktop so that one application opens on one interactive whiteboard, and another application opens on the second interactive whiteboard.

You must orient each interactive product separately so that the pointer is properly aligned when you touch the product. To do this, open the SMART Board Control Panel and select Align/Orient the SMART Board. Refer to the Help Center for the specific procedure to orient each display.

After you set up your multiple displays, each display has touch control. However, some applications can’t accept cursor commands/mouse input from more than one source at a time. This won’t be a problem if you use Notebook software, because it can accept multiple inputs. You’ll need to enable the multiple touch setting in Control Panel > SMART Board Settings > Mouse Settings. Read the topics under How To > Changing the SMART Board Software Settings > Mouse Settings in the Help Center for instructions.

For more information on setting up multiple SMART products, read the Technical Bulletin Connecting Multiple Interactive Whiteboards to One Computer that’s available at www.smarttech.com/support/bulletins/sb.asp.
Using SMART Board Software in Non-Projected Mode

CAUTION

Do not use the non-projected mode if you own a SMART Board interactive whiteboard with an OptiPro™ surface, a Sympodium interactive pen display, a Rear Projection SMART Board or a SMART Board for Flat-Panel Displays interactive whiteboard. These products are optimized for use with SMART Board software in projected mode. If your product has an OptiPro surface, don’t mark it with dry-erase ink.

In Non-Projected (Whiteboard) mode, you can write on the screen with dry-erase markers just as you would on an ordinary whiteboard. However, unlike an ordinary whiteboard, what you write is simultaneously displayed on a Notebook page.

In this mode, the computer scales the size of the writing area in Notebook software to the size of the interactive screen. This scaling is automatic, but you can orient the display if the sizing doesn’t suit you. You must change the default mode setting for your interactive product and SMART Board software.

**Setting Up the Pen Tray for Non-Projected Use**

In non-projected mode, the upper pen tray button is the New Page button, which is a very important button for non-projected use. When you press this button, a new page opens in the current Notebook file to receive your notes. The bottom button is the Print button, which sends your current page of notes to the computer’s default printer.

To equip the pen tray, purchase a set of high-quality, dry-erase markers in black, blue, red and green. Place each pen in the matching color slot of the pen tray.

**Setting Up SMART Board Software for Non-Projected Use**

The default mode for SMART Board software is the Projected (Mouse) mode. However, if you’re using your interactive whiteboard without a projector, you should change the software mode to **Non-Projected (Whiteboard Mode)**. To access this option, open the SMART Board Control Panel and select SMART Board Settings. Otherwise, when you write anywhere other than on the Notebook page, you may accidentally activate menu commands or other program elements.
NOTE: If you’re using SMART Board software in non-projected mode, you can only connect one SMART interactive product to your computer.

**Working with Your Notes in Non-Projected Mode**

Open Notebook software.

When you write on the interactive whiteboard in non-projected mode, you can see your note on the Notebook page. If you don’t want to keep your notes, simply erase the dry-ink markings on the interactive whiteboard. This erases the electronic ink on the computer as well.

To keep your notes, save your Notebook file.

To write on a new page, press the **Insert Blank Page** button in Notebook software. With this blank page open, erase the dry-erase ink on your interactive whiteboard and create a new set of notes.

**Using the Display Control Icon Strip**

If you have a SMART Board for Flat-Panel Displays interactive whiteboard, you received a Display Control icon strip. (Previous models also had a Tool Icon Strip and a Custom Strip.) You can set up and use this strip to control your flat-panel display.

For details on using these strips, refer to the installation and user’s guide that came with your model, and read the SMART Board Help Center topics on the Display Control strip.
Maintenance for Front Projection Models

This section pertains to front projection SMART Board interactive whiteboards only. For other SMART interactive products, refer to the installation guide that came with your product for maintenance and cleaning information.

Cleaning Your Interactive Whiteboard and Pen Tray

For optimal clarity, clean a frequently used interactive whiteboard and pen tray approximately once a week. Spray a soft cloth with standard glass or whiteboard cleaner and then wipe the surfaces.

If the bottom of the pen tray slot becomes heavily soiled, the infrared transmitter and receiver could become obstructed. If this happens, the system will not detect when the eraser or a pen is removed. The slot LED won’t light, and the lifted tool won’t work. If this happens, moisten a cotton swab with standard glass cleaner, and carefully clean the infrared transmitter and receiver.

NOTES

• Before you clean the SMART Board interactive whiteboard, shut down the computer. Otherwise, you’ll scramble the desktop icons or activate application components when you touch the screen.

• To view dirt and streaks more easily, put the projector on standby (turn the lamp off).

Removing Permanent Marker Ink Stains

To remove marks made with a permanent marker, you can use a cleaner such as the Sanford Expo® Dry Erase Board Doctor. Just write directly over the permanent ink stain with the Board Doctor pen, allow the solution to dry completely and then wipe clean.

You can also use a high-odor dry-erase marker to remove marks from a permanent marker because dry-erase ink contains solvents that work to
remove permanent ink. To do this, cover the permanent ink with the dry-erase ink and wipe with a soft cloth while the ink is still wet. If any trace of the ink remains, spray a cloth with standard glass or whiteboard cleaner and wipe the area clean.

**TIP**

When removing permanent marker ink, don’t use low-odor or non-scented dry-erase markers. They don’t contain the appropriate solvents.

**Preventing Damage to the Writing Surface**

Keep sharp writing instruments, such as ballpoint or fine-point pens, away from the interactive whiteboard. Although the front projection SMART Board interactive whiteboard is very durable, these types of pens can damage the screen surface if they’re applied with heavy pressure.

Also, don’t let abrasive erasers or abrasive cleaning materials come in contact with the interactive screen.

**General Tips for Trouble-Free Performance**

Ensure that the interactive whiteboard is connected to a USB or serial port that’s recognized by the operating system and that’s not being used by another application.

Make sure all the pens and the eraser are placed securely in the pen tray if you want to use your finger to click. If you lose a pen, place another object in its pen tray slot. Otherwise, the interactive whiteboard senses which tool is missing from the pen tray and the software assumes that the missing tool is the one you’re currently using on the interactive surface.

If you mount the interactive whiteboard on the wall, leave enough room on either side for you to stand beside it.

**Transporting the Interactive Whiteboard**

If you need to ship your interactive whiteboard, we urge you to repack it in as much of the original packaging as possible. If your original packaging is no longer available, you may purchase the same packaging directly from a Technical Support representative of SMART Technologies (see page 86 for contact information).
If you prefer to use your own packaging materials, make sure you adequately protect the interactive whiteboard and keep the pen tray attached, if possible. We also recommend that you ship the unit in an upright position in order to deter shippers from placing heavy objects on it.

If you ship your interactive whiteboard frequently, consider purchasing a more durable, hard shipping case from SMART Technologies. With its foam-lined interior, aluminum edges and valances, and steel-reinforced corners, this shipping case protects both your SMART Board interactive whiteboard and, if you have one, a floor or table stand. The case has dual tilt wheels for ease of transport. If you own a SMART Board 640 interactive whiteboard, you may prefer a specially designed carrying bag. For any of these items, please contact the dealer from whom you purchased your interactive whiteboard.

**Removing the Pen Tray**

Although you normally won’t need to remove the pen tray, it might be necessary to do so for the purposes of transportation or repair.

**To remove the pen tray**

1. Shut down the computer that’s connected to the interactive whiteboard by following the manufacturer’s recommended shutdown procedures.
2. Remove the pens and eraser from the pen tray.
3. Reach underneath the pen tray on the right side and disconnect the MOD6 cable from the port labeled 1.
4. Reach underneath the pen tray and pull down on the two large plastic clips on the bottom of the pen tray. The ends of these clips project slightly downwards, so they’re easy to locate.

*The Pen Tray as Seen from Below*

![Plastic Clips]

5. While continuing to apply downward pressure to the clips, gently slide the pen tray toward you until it’s free of the two brackets.

**Adjusting the Projected Image**

For both rear and front projection SMART Board interactive whiteboards, you can fix many image problems by shifting the projector or adjusting the zoom lens. Optimally, you should have a margin of approximately 3/8" (1.0 cm) on both the right and left sides of the screen.

You should ensure that the resolution settings for your projector and computer match. Set the projector to its optimal image resolution by following the instructions in your projector’s manual. Then set your computer’s resolution to match.

If the resolutions don’t match, the computer’s image output won’t properly fill the interactive screen and may shimmer or be distorted. You can change your computer’s resolution in the *Display Properties* dialog box, which you can access by double-clicking *Display* in the *Windows Control Panel*. If you need further help setting your computer resolution, see the Help for your operating system.
Troubleshooting Front Projection Models

**NOTE:** If you’re using a product other than a front projection SMART Board interactive whiteboard, read the troubleshooting information in the installation and user’s guide that came with your product.

**Understanding the Ready Light**

The Ready Light indicates the current status of your interactive whiteboard, as described in the table below.

<table>
<thead>
<tr>
<th>Ready Light</th>
<th>Current Status of Interactive Whiteboard</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Green</td>
<td>Normal State: You can both control and write over the projected computer image.</td>
<td>None required.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Mouse Mode: You can control applications with touch but not write over them.</td>
<td>None required if you only want touch control. (This may be the preferred mode for guest laptops.)</td>
</tr>
<tr>
<td></td>
<td>Either SMART Board software hasn’t been installed, or the software is installed but SMART Board Service isn’t running.</td>
<td>To make use of the pen tray tools to write over the computer image, install SMART Board software, make sure SMART Board Service is running, and open the Tools.</td>
</tr>
<tr>
<td>Ready Light</td>
<td>Current Status of Interactive Whiteboard</td>
<td>Action</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Red</td>
<td>Communication with SMART Board software hasn’t started or has stopped. <strong>NOTE:</strong> During initial power up or power reset, you will see the Ready Light turn red for a moment. This <em>brief</em> red illumination is normal behavior.</td>
<td>If the Ready Light remains red for more than a few seconds, see the <em>Troubleshooting Table</em> for recommendations.</td>
</tr>
<tr>
<td>Amber</td>
<td>Problem State</td>
<td>See the <em>Troubleshooting Table</em> for recommendations.</td>
</tr>
<tr>
<td>Flashing Amber</td>
<td>Normal State: Occurs only when you are updating firmware using SMART’s Firmware Flashing Wizard.</td>
<td>No action necessary. Updating firmware is only required in special circumstances.</td>
</tr>
</tbody>
</table>

### Troubleshooting Table

Should you experience a problem with your interactive whiteboard, you can troubleshoot it by using the Ready Light, in conjunction with other observable symptoms and behaviors. The following troubleshooting table will help you identify and then correct the problem.

**NOTE:** To start the SMART Board Service, open the SMART Board Control Panel and press **About Software and Product Support**. In the *SMART Technical Support* window, press the **Diagnostics** button. If the message **The SMART Board Service is not running** appears in the **Status** area of the *SMART Board Service Log* window, press **Service > Start**.
<table>
<thead>
<tr>
<th>Symptoms/ Observations</th>
<th>SMART Board Software Installed?</th>
<th>Interactive Whiteboard State/Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready Light steady green.</td>
<td>Yes (SMART Board Service and Tools are both open)</td>
<td>Normal fully operational state: You have both touch control and pen tray tool use. The interactive whiteboard is powered and communicating with installed SMART Board software.</td>
</tr>
<tr>
<td>Pen tray LEDs turn on when tool is lifted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Problem state: Removal of the pen tray tool is not recognized by the computer. Make sure all other tools are in their slots. Check if the sensor at the bottom of the pen tray tool slot is blocked or requires cleaning. If so, remove the obstruction or use a slightly damp cotton swab to carefully clean the sensor. If the pen tray tool slot is clean and unobstructed, reset the interactive whiteboard’s power (as described on page 79). If the problem remains, call SMART Technical Support (page 86).</td>
</tr>
<tr>
<td>Ready Light is steady green.</td>
<td>Yes, and SMART Board Service is running and SMART Board Tools are open.</td>
<td></td>
</tr>
<tr>
<td>You lift a tool from the pen tray to write or erase, but pressing only produces a left-click or the behavior of the previously removed tool. The LED associated with the tool does not turn on when that tool is lifted.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symptoms/Observations</td>
<td>SMART Board Software Installed?</td>
<td>Interactive Whiteboard State/Remedy</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------</td>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ready Light steady green. Touch control available, but pen tray tools do not work.</td>
<td>Yes.</td>
<td>Problem state. Reset the interactive whiteboard’s power (as described on page 79). If the pen tray LEDs flash twice in quick succession, the cable connections are secure.</td>
</tr>
<tr>
<td>Pen tray LEDs don’t turn on when tool is lifted.</td>
<td></td>
<td>If the pen tray LEDs do not flash twice in quick succession, check that the cable connections under the pen tray and on the controller (on the back of the unit) are secure.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If problem persists, call SMART Technical Support (page 86).</td>
</tr>
<tr>
<td>Ready Light blinking green. Touch control available, but the pen tray tools don’t</td>
<td>Yes.</td>
<td>Problem state if you were expecting to write over the projected image.</td>
</tr>
<tr>
<td>work. You can’t write over the image, as you expected.</td>
<td></td>
<td>Even if you’ve installed SMART Board software, if you want to use the pen tray tools, the SMART Board Service must be running and SMART Board software must be open.</td>
</tr>
<tr>
<td>Pen Tray LEDs don’t turn on when tool is lifted.</td>
<td></td>
<td>Start the SMART Board Service and make sure the SMART Board icon ☐ is in the Windows system tray.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open the SMART Board Software folder in the Start menu’s list of programs and select SMART Board Tools for the icon to appear and the pen tray tools to function as expected.</td>
</tr>
<tr>
<td>Symptoms/Observations</td>
<td>SMART Board Software Installed?</td>
<td>Interactive Whiteboard State/Remedy</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Ready Light blinking green.                                | No                              | Normal “mouse mode” state.  
**NOTE:** Guest laptop users may prefer this mode for giving a brief presentation.  
However, if you prefer to write over the projected image, install SMART Board software and make sure SMART Board Tools are open.  
If the SMART Board icon doesn’t appear in the Windows system tray, open the **SMART Board Software** folder in the Start menu’s list of programs and select **SMART Board Tools**. The icon will appear and the pen tray tools should now function as expected. |
| Touch control available, but pen tray tools do not work.   |                                 |                                                                                                                                                                                                                                                                                                                                                     |
| Pen tray LEDs don’t turn on when tool is lifted.           |                                 |                                                                                                                                                                                                                                                                                                                                                     |
| Pen tray LEDs flash sequentially twice                     | Yes                             | Normal state.  
Pen tray is powering up.                                                                                                                                                                                                                                                                                                                                          |
| Ready Light is amber                                       | Yes                             | Problem state.  
Reset the interactive whiteboard’s power (as described on page 79).  
If Ready Light remains amber, call SMART Technical Support (page 86).                                                                                                                                                                                                                    |
<table>
<thead>
<tr>
<th>Symptoms/Observations</th>
<th>SMART Board Software Installed?</th>
<th>Interactive Whiteboard State/Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ready Light is not lit. No touch control of the image. Pen tray LEDs don’t turn on when tool is lifted.</td>
<td>Yes</td>
<td>Problem state: No power from the computer to the interactive whiteboard. Ensure the USB connections at the interactive whiteboard and computer ends are secure. If they are, you may have a faulty cable. Call SMART Technical Support (page 86). <strong>NOTE:</strong> If you’re using an RS-232 serial expansion module, ensure that you’ve plugged in the power supply and that you’ve securely connected the module to the back of the unit.</td>
</tr>
<tr>
<td>Ready Light turns from steady green to steady red. No touch control of the image. Pen tray LEDs don’t turn on when tool is lifted.</td>
<td>Yes</td>
<td>Problem state: Interruption of communication between the interactive whiteboard and the service component of SMART Board software. Reset the interactive whiteboard’s power (as described on page 79). If the Ready Light remains red, restart your computer. If the Ready Light remains red, call SMART Technical Support (page 86).</td>
</tr>
<tr>
<td>Ready Light remains steady red from start-up onwards. It never proceeds to either steady green or flashing green states.</td>
<td>Yes</td>
<td>Problem State: The HID driver in your operating system isn’t functioning properly. Try unplugging and then reconnecting the SMART USB cable. If the Ready Light remains red, shut down and then restart your computer. If the problem persists, call Technical Support (page 86).</td>
</tr>
</tbody>
</table>
Resetting the Interactive Whiteboard’s Power

You can solve several problems by resetting the power to the interactive whiteboard. This forces the hardware and firmware to re-initialize, which can restore normal behavior.

To perform a power reset

Disconnect and then reconnect the USB cable at the interactive whiteboard end.

OR

Using the tip of a pen tray pen, briefly press (for no longer than three seconds) the Power Reset button, located behind the interactive whiteboard, at the lower-right side (when viewed from the front).

NOTE: If you press and hold the Power Reset button for longer than three seconds, the orientation of the whiteboard will default to the factory orientation. In this case, alignment will be correct only if the computer image exactly fills the screen.
## General Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The image doesn’t fill the screen fully. OR The image is blurry.</td>
<td>The computer’s resolution setting may not match your projector’s native resolution. Consult your projector manual for the correct resolution, and then go to the <em>Windows Control Panel</em> to change the display resolution of your monitor.</td>
</tr>
<tr>
<td>Touch is not accurate. The pointer does not appear directly below your finger. When you write on the screen, your writing appears at a slight distance from the pen.</td>
<td>Orient the interactive whiteboard (see page 14).</td>
</tr>
<tr>
<td>No digital ink appears on the screen</td>
<td>Check that SMART Board software is installed and running.</td>
</tr>
</tbody>
</table>
Wall-Mounting Tips for Front-Projection Models

CAUTION

Two people are required to mount the front-projection interactive whiteboard on a wall. The interactive whiteboard may be too heavy for one person to easily maneuver onto the wall-mounting bracket.

Wall-Mounting Precautions and Tips

- If you need to lean the whiteboard against a wall before you mount it, make sure it remains in an upright position, resting on the pen tray brackets. These brackets are designed to sustain the weight of the whiteboard. Do not lean the whiteboard against the sides or the top of the frame, as this could damage the product.

- To wall-mount an interactive whiteboard, you must first secure a bracket on the wall from which the whiteboard will hang. You must screw five anchors into the wall, which will receive the screws that secure the bracket. Do not use a hammer to tap these anchors into the wall. Simply screw the anchor into the wall with a Phillips No. 2 screwdriver.

- If you find it impossible to screw any of the five anchors into the wall, you’ve likely encountered a stud behind the drywall surface. If this is the case, you don’t need to use an anchor in this location. The stud will provide more than adequate anchorage for the screw that secures the bracket to the wall.
• If you’re mounting the whiteboard on a brick or cinder-block wall, do not use the wall anchors supplied with the interactive whiteboard. You must purchase and use appropriate wall anchors that are rated for at least 20 lb. (9.1 kg).

• When you lift the whiteboard onto the wall bracket, make sure it’s secure by sliding it slightly sideways before you release it.

• Before you mark the location of the pen tray bracket anchors, push the center tab of each bracket so that it’s flush with the wall behind it.

• When you secure the MOD6 cable to the port labeled 1 on the underside of the pen tray, push the cable into the strain-relief channel. This protects the MOD6 connector from damage if the pen tray is removed without first disconnecting the cable.
Recommended Heights for Wall-Mounting

You should consider the general height of your user community when you choose a location for your wall-mounted whiteboard. If the whiteboard is too low, tall people may be forced to bend over uncomfortably; if it’s too high, short people may need to reach up too far.

Use these guidelines to determine the optimal height for your front-projection interactive whiteboard.

**NOTE:** All the following heights are measured to the bottom of the wall-mount bracket holes.

**For Children and Adults in Wheelchairs**

![Interactive Whiteboard Models]

<table>
<thead>
<tr>
<th>Interactive Whiteboard Model</th>
<th>Distance from Floor to Bottom of Bracket</th>
<th>Distance from Floor to Top of Whiteboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Board 680</td>
<td>59 1/2&quot; (151.1 cm)</td>
<td>63 3/4&quot; (161.9 cm)</td>
</tr>
<tr>
<td>SMART Board 660</td>
<td>56 1/2&quot; (143.5 cm)</td>
<td>60 3/4&quot; (154.3 cm)</td>
</tr>
<tr>
<td>SMART Board 640</td>
<td>51 1/2&quot; (130.8 cm)</td>
<td>55 3/4&quot; (141.6 cm)</td>
</tr>
</tbody>
</table>
### For Adults of Average Height

<table>
<thead>
<tr>
<th>Interactive Whiteboard Model</th>
<th>Distance from Floor to Bottom of Bracket</th>
<th>Distance from Floor to Top of Whiteboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Board 680</td>
<td>77 1/2&quot; (196.8 cm)</td>
<td>81 3/4&quot; (207.6 cm)</td>
</tr>
<tr>
<td>SMART Board 660</td>
<td>69 1/2&quot; (176.5 cm)</td>
<td>73 3/4&quot; (187.3 cm)</td>
</tr>
<tr>
<td>SMART Board 640</td>
<td>69 1/2&quot; (176.5 cm)</td>
<td>73 3/4&quot; (187.3 cm)</td>
</tr>
</tbody>
</table>

### Low Enough for Children or Short Adults/High Enough to Clear Typical Obstructions to the Projected Image

<table>
<thead>
<tr>
<th>Interactive Whiteboard Model</th>
<th>Distance from Floor to Bottom of Bracket</th>
<th>Distance from Floor to Top of Whiteboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>SMART Board 680</td>
<td>77 1/2&quot; (196.8 cm)</td>
<td>81 3/4&quot; (207.6 cm)</td>
</tr>
<tr>
<td>SMART Board 660</td>
<td>69 1/2&quot; (176.5 cm)</td>
<td>73 3/4&quot; (187.3 cm)</td>
</tr>
<tr>
<td>SMART Board 640</td>
<td>59 1/2&quot; (151.1 cm)</td>
<td>63 3/4&quot; (161.9 cm)</td>
</tr>
</tbody>
</table>
Securing the Pen Tray and Interactive Whiteboard

The pen tray that comes with your SMART Board interactive whiteboard is detachable. You may want to safeguard the pen tray—and of the interactive whiteboard at the same time—by connecting it to a security cable.

If you look underneath the pen tray, you'll find a lock slot, which is designed to accommodate a security cable, such as a Kensington® lock.

Loop the cable around a desk leg or another heavy or immovable object to secure it, and thread the lock end of the cable through the loop end of the cable. Then insert the prong-end of the Kensington lock into the lock slot.

**IMPORTANT**  
Securing the pen tray can provide theft protection for the interactive whiteboard as well.

The screws that secure the whiteboard to the wall are located directly behind the pen tray. To access these screws, you must first remove the pen tray. In effect, when you secure the pen tray, you’re also securing the interactive whiteboard, if the security cable is tight.
Contacting SMART Technologies

Contacting SMART Technical Support

SMART’s Technical Support team welcomes your call. However, you may first want to contact your local reseller if you experience difficulties with your SMART product, as they may be able to solve the problem without delay.

All SMART products include free telephone, fax and e-mail support.

**Telephone:** 1.866.518.6791 (toll-free in Canada/U.S.) or +1.403.228.5940 (all other countries)  
(Available 7 a.m. – 6 p.m. Mountain time from Monday to Friday)

**Fax:** +1.403.806.1256

**E-Mail:** support@smarttech.com

**Website:** www.smarttech.com/support

When you phone Technical Support, it will be helpful if you can access your computer during the call. The support representative may ask you for the following information:

- the serial number of your interactive product
- the version of the software that’s causing the problem and the version of your computer’s operating system

General Inquiries

**Main Switchboard:** 1.888.42.SMART (toll-free in Canada/U.S.) or +1.403.245.0333 (all other countries)  
(Available 7 a.m. – 6 p.m. Mountain time from Monday to Friday)

**Fax:** +1.403.228.2500

**E-Mail:** info@smarttech.com

**Address:** SMART Technologies Inc.  
1207 – 11 Avenue SW, Suite 300  
Calgary, AB T3C 0M5  
CANADA
Returning Defective Merchandise

All SMART 500 and 600 series interactive whiteboards, all Rear Projection SMART Board interactive whiteboards and Sympodium interactive pen displays are covered by a two-year limited equipment warranty. All SMART Board for Flat-Panel Displays interactive whiteboards are covered by a one-year limited equipment warranty. To return defective merchandise, call SMART Technical Support. You will receive the appropriate Return of Merchandise authorization and instructions for transporting your unit to an authorized service center.

Warranty Shipping Charges

You are responsible for transporting the system to the service center, and SMART pays return shipping via ground service on any product that’s returned for service within the warranty period. If you request a rush order, any associated charges are billed to you. Read the warranty that was included with your SMART product for details.

NOTE: After the warranty period, you are responsible for transporting the product to and from the service center.

Registration

A User Registration card was included with your SMART product. To help us serve you better, fill in and mail this card to SMART Technologies Inc. or register online at: www.smarttech.com/registration.

Sending Feedback

You can help us improve our documentation by e-mailing your comments to TechnicalDocumentation@smarttech.com. We’d love to hear from you!

Obtaining More Information

Visit www.smarttech.com/support to:

- download PDF versions of our user guides, installation instructions and more
- read technical bulletins, FAQs and tips
- troubleshoot a problem
- explore our resource centers to learn about conferencing and room control systems
Index

A
Adding
   Buttons to the Start Center 13
   Content to the Gallery 32
   File Attachments 33
   Flash Files 34
   Flash Files to the Gallery 34
   Gallery Content 30
   Images 34
   Links 33
   Pages 27
   Scanned Images 35
   Shapes 29
   Shapes to a Notebook
      Page 24
   Shortcuts 33
   Text 29, 53
   To Floating Tools 23, 44
   To Start Center 43
Adjusting, Projected Image 72
Aligning 14
Attaching Files 33
AutoCAD 22
Auto-Hide, Notebook Software 47

B
Black Slides 63
Border 22
   Removing 22
Brainstorming 41
Bridgit Software 64
Browse the Internet 13
Bulb Saver 17
Buttons, Non-Projected Mode 67

C
Capturing 38
   Non-Projected Mode 68
   Presentations 60
Categories of Gallery Content 31
Changing 43
   a Floating Tool 48
   Desktop Spotlight 58
   Digital Ink 48
   Eraser Size 36
   Floating Tools 44
   Notebook Interface 46
   Objects in Notebook
      Software 25
   PowerPoint Software 49
   Recorder 49
   Recording Locations 42
   Resolution 72
   Settings 45
   Start Center 43
   View of Notebook Page 47
   Your Movie Recording
      Settings 42
Circle 29
Classic Keyboard View 28
Classic Tool Set 23
Cleaning 69
Clicking 13
Code Reviews 56
Collections, see Gallery 32
Components of SMART Board
   Software 3
Conferences
   Presenting 63
   Saving Content 42
Connecting, Laptop 52
Controlling 13
   Displays 17
   PowerPoint Presentations 63
   Presentations 57
Copying Objects Between
   Pages 27
CorelDRAW Drawing 22
Correcting Mistakes 36
Creating Templates 31
Creative Ink 24
Custom Strip 68

Data Conferences 42
Deleting, Non-Projected Mode 68
Demonstrating Software 56
Desktop, Multiple Screens 65
Digital Ink
  Changing 48
  Removing 36
Display
  Adjusting 72
  Laptops 19
Display Control 17
  Icon Strip 68
Double-clicking 13
Dragging
  onto Notebook Pages 35
  to Start Center 43
DVD Player, Connecting 18, 27
DVIT Technology 14
  Tips for Using 16

Education, Content 31

E-Mailing
  Notes 52
  Recorder Files 50
Erasing 36
  Large Areas 37
Excel
  Capturing 38
  Converting to Text 22
  Inserting 40
  Writing 21
Expanding the Page Sorter 47
Exporting
  Gallery 32
  Notebook Files 42
Extending a Page 27

F
Files
  Formats 34
  Linking 34
  Linking to Objects 26
Flash Files 34
Flat-Panel Displays 16
  Display Control 17
  Icon Strips 68
Floating Tools
  Adding 44
  Capturing 39
  Changing 44
  Changing a Tool 48
  Eraser 36
  Undo 36, 37
Font 28
Formats
  Notebook Files 50
  Saving 42
Formatting Text 29
Front Projection 70
  Cleaning 69
  Maintenance 69
  Multiple Products 65
  Safety i
Full Screen View 46, 60
  Using 57

G
Gallery 30
  Adding Content 32
  Content 31
  Organizing Content 33
  Sharing Content 32
  Templates 31
Grouping Objects 25
Guest Laptop Switch 20, 52
Guest Presenter 60
Handouts
  Meeting Minutes 56
  Printing Notebook Pages 53
Handwriting
  Conversion 21, 29
  Recognition 29
Heights for Interactive Whiteboard 83
Icon Strips 68
Image Troubleshooting 80
Images 34
  Scanning 35
  Importing 33, 57
  Flash Files 34
Injecting 23
  PowerPoint 63
  Text 29, 53
Ink Aware
  Capturing 38
  Definition 21
  Drawing 22
  Inserting 41
  Writing 21
Ink Color 48
Interactive Whiteboard
  Installation Heights 83
Interactive Whiteboards
  Clicking 13
  Installing 81
  Resetting Power 79
  Writing 21
Keeping Side Tabs in View 46
Keyboard 28
Laptop
  Connecting 20, 52
  Sharing 51
LED 4, 73
  Troubleshooting 75
Line
  Ends 25, 48
  Style 48
  Thickness 48
Linking to Websites or Files 26
LinQ Software 20
  Presenting 64
  Saving 51
Locked Gallery 33
Locking Objects 26
Logging On 6
Lost Notes 37
Magnifier 19, 55, 58
Marker, Removing Ink Stains 69
Meetings 56
Mobile Device Manager 20, 51
Mode, Non-Projected 67
Mounting an Interactive Whiteboard 81
Mouse Gestures 16
Mouse Settings 15, 16
Moving
  Interactive Whiteboards iii
  Objects on the Interactive Screen 14
  Pages 27
  Toolbar 46
Multiple Interactive Products 65
Multiple Touch Mode 16
Navigating 61
  in Presentations 61
  PowerPoint Software 62
NetMeeting 64
Network
  LinQ Software 60
  Software Installation 7
Non-Ink Aware
  Capturing 38
Non-Projected Mode 67
Normal View 46
Notebook Software
Capturing 38, 39
Changing 46
Linking 33
Navigating 61
Non-Projected Mode 67
Preparing Presentations 56
Presenting 60
Saving in Different Formats 50
Shortcuts 34
Text 29
Writing 24

Notes
Capturing Video and Notes 42
During a Presentation 60
Inserting in Ink Aware Applications 41
Inserting into PowerPoint Software 41
Inserting into Word or Excel Files 40
Non-Projected Mode 68

Number Pad Keyboard View 28

Objects 25
Linking 26
Overlapping 26

Opening
Keyboard 28
Start Center 13

Operating System 5
Organization of the Gallery 30
Organizing Presentations 56
Organizing Your Gallery Content 33
Orienting 5, 14
Changing Precision 46
Multiple Displays 66

P
Page Sorter 47
Pages 27
Paint, Drawing 22
Pausing a Video 18
Pen Tray 69, 71
Non-Projected Use 67
Pens, Changing 45
Pictures, see Images 34
Play a Video 18
Pointer Tool 29, 59
Power, Resetting a Pen Tray 79
PowerPoint 62
Capturing 38
Changing 49
Inserting 41
Writing 21
Preparation Your Presentation 56
Presenting 55, 56
Conferences 63
Displaying the Screen 19
Magnifier 58
Notebook Software 60
Notebook Views 46
Pointer Tool 59
PowerPoint Software 62
Preparing 56
Saving 60
Screen Shade 58
Spotlight 58
Pressing 4, 15
Previous Versions 5
Print Capture 39, 57
Printing
Notebook Pages 52
Using Print Capture to Add Notes 54
Professional Content 31
Projected Image 72
Projector 16
Adjusting 72
Resolution 72
Protecting Objects from Editing 26
R
Ready Light 73
  Troubleshooting 75
Ready Light, 500 Series 4
Recorder 41
  Changing 49
  E-Mail Files 50
  Lessons 50
  Saving Presentations 60
Rectangle 29
Removing 69, 71
  Border 22
  Notes and Digital Ink 36
Resetting the Power 79
Resolution 72
Restoring Notes 36, 37
Right-clicking 14
Ruler 26

S
Safety Information i
Saving
  Changes to the Software 43
  Formats 42
  PowerPoint Notes 63
  Presentation 60
  Video and Notes 42
Screen Capture
  During a Presentation 60
Screen Saver 17
Screen Shade 29, 58
  Notebook Software 61
Serial Number 2
Setting Up, Non-Projected Mode 67
Shapes 24, 59
  Floating Tools 29
Sharing 50
  From Other Applications 53
  Gallery Content 32
  Recorder 50
Shortcut Keyboard View 28
Shortcuts 33
  Notebook Software 61
Side Tabs 46
Simple Keyboard View 28
SMART Board Service 74
SMART Board Software
  Changing the Mode 67
  Non-Projected Mode 67
  Settings 45
  Versions 7
  Without a Projector 67
SMART Bulb Saver 17
SMART Ideas 57
SMART Products 2
Spotlight 29, 58
Stacking Objects 26
Stains 69
Star 29
Start Center 13
  Changing 43
Starting the Software 5
Subcategories in the Gallery 33
Support, Contacting 86
Switching Laptops 52
Symposium Interactive Pen Display
  Clicking 14
  Writing 21

T
Taking Meeting Notes 56
Teachers
  Accommodating Younger Students 44
  Content 31
  Recording Lessons 50
  Safety Tips iv
Templates 31, 32
Text Injecting 53
Tips 69
  Interactive Whiteboard
  Performance 70
  Mounting an Interactive Whiteboard 81
  Pen Tray 70
  Pressing 15
Titles 27
Tool Icon Strip 68
Tool Set 23
Touch Control, Changing Orientation Level 46
Transparent Layer 22
Removing Border 22
Spotlight 59
Toolbar 44
Transporting the Interactive Whiteboard 70
Troubleshooting 4, 70
Interactive Whiteboards 73
Types of Meetings 56
Typing Into an Application or Dialog Box 28
Notebook Software 29

V
VCR Connecting 18, 27
Versions 7
Video Capturing 41
Devices 18
Writing 27
Video Player 18
Videoconference 42

W
Web Links 33
Objects 26
Whiteboard Mode 67
Wireless Adapter iii
Word Capturing 38
Inserting 40
Writing 21
Write Keyboard View 28
Writing 21
Over Video 18, 27